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ΠΕΡΙΛΗΨΗ 
Ο τουριστικός κλάδος εξαρτάται και στηρίζεται από τις υπηρεσίες που προσφέρουν οι νέες 
τεχνολογίες και ειδικότερα η χρήση του Διαδικτύου. Το Διαδίκτυο αποτελεί μέρος της 
καθημερινότητας πολλών ατόμων. Η ευρεία χρήση του αποτέλεσε την έναρξη διαφόρων 
δραστηριοτήτων μέσω διαδικτύου όπως το ηλεκτρονικό μάρκετινγκ και η ηλεκτρονική 
διαφήμιση, τα οποία σε συνδυασμό με τις πολυμεσικές εφαρμογές αποτελούν ένα δυνατό 
μέσο προώθησης. Η παρούσας πτυχιακή εργασία διερευνά την χρήση των νέων τεχνολογιών 
και των πολυμεσικών εφαρμογών στην ανάπτυξη και την προώθηση του τουρισμού, μέσα 
από μια διαδραστική πολυμεσική εφαρμογή. Η επεξεργασία των βίντεο έγινε με το λογισμικό 
Windows Movie Maker και η εφαρμογή έγινε με το λογισμικό Matchware Mediator 9. 

 

 

 

 

 

        

 

 

 

 

 

 

 

 

 

 

 

 

ΛΕΞΕΙΣ ΚΛΕΙΔΙΑ 
Διαδίκτυο, ηλεκτρονικό μάρκετινγκ, ηλεκτρονική διαφήμιση, πολυμεσικές εφαρμογές, νέες 
τεχνολογίες   

 



 
iv 

 

ABSTRACT 
The tourist industry is depended and supported from the services offered by new 

technologies and in particular the use of the Internet. The Internet is part of everyday life of 
many people. Its widespread use was the start of various activities over the Internet such us e-
marketing and e-advertising which in combination with multimedia applications are a 
powerful means of promotion. This thesis explores the use of new technologies and 
multimedia applications in the development and promotion of tourism through an interactive 
multimedia application. The edit of the videos was done with Windows Movie maker 
software and the application was done with Matchware Mediator 9. 
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1. ΕΙΣΑΓΩΓΗ 
Στην σημερινή εποχή τα πάντα αλλάζουν με αλματώδεις ρυθμούς. Νέες τεχνολογικές 
εφαρμογές κάνουν καθημερινά την εμφάνισή τους, αλλάζοντας τον τρόπο ζωής, εργασίας, 
επικοινωνίας και ψυχαγωγίας. Οι νέες τεχνολογίες σε συνδυασμό με τις διαδραστικές 
πολυμεσικές εφαρμογές επηρέασαν τον τομέα του τουρισμού στην ανάπτυξη και στην 
προώθηση του. Τα τελευταία χρόνια, η υιοθέτηση των νέων τεχνολογιών και των 
διαδραστικών πολυμεσικών εφαρμογών από την βιομηχανία της κρουαζιέρας, συντέλεσαν 
στην αναβάθμιση των παρεχόμενων υπηρεσιών στους πελάτες τους και στην καλύτερη 
διαφήμιση των τουριστικών προορισμών. Ο τομέας της κρουαζιέρας αποτελεί ένα χώρο ο 
οποίος πρέπει να βρίσκεται συνεχώς κοντά στις τεχνολογικές εξελίξεις και να προσαρμόζεται 
στις ανάγκες των ταξιδιωτών και την παροχή σε αυτούς μιας ολοκληρωμένης και αξέχαστης 
εμπειρίας. Οι επιχειρήσεις που δραστηριοποιούνται στον τομέα της κρουαζιέρας πρέπει να 
ενσωματώνουν άμεσα τις νέες τεχνολογίες, ώστε να παραμένουν ανταγωνιστικές και να 
ανταποκρίνονται στις σύγχρονες απαιτήσεις.  

Η παρούσα πτυχιακή εργασία αναφέρεται στον τρόπο "Δημιουργίας διαδραστικής 
πολυμεσικής εφαρμογής ως εργαλείο προώθησης για την βιομηχανία της κρουαζιέρας". Ως 
σημείο αναφοράς της δημιουργίας της πολυμεσικής διαδραστικής εφαρμογής επιλέχθηκε το 
Κατάκολο Ηλείας, διότι είναι μια περιοχή ιδιαίτερου φυσικού κάλους με πολλούς επισκέπτες 
από όλο τον κόσμο κάθε χρόνο. Η ναυτιλιακή εταιρεία "SeaCruises" που εμπεριέχεται στην 
εφαρμογή είναι εικονική. Το περιεχόμενο της παρούσας πτυχιακής εργασίας και της 
εφαρμογής προέρχεται από έγκυρες πηγές τόσο βιβλιογραφικές όσο και ηλεκτρονικές. Οι 
εικόνες και τα βίντεο που εμπεριέχονται στην εφαρμογή αποτελούν υλικό ελεύθερης 
προέλευσης από σελίδες του διαδικτύου, ενώ οι πληροφορίες για το Κατάκολο Ηλείας και 
των Μουσείων προέρχονται από τις διαδικτυακές πύλες www.katakolo.info/el/,  
www.kotsanas.com και www.kotsanas.com/mousika.php, για να βεβαιωθεί η ακρίβεια των 
ιστορικών πληροφοριών.       

Η παρούσα πτυχιακή εργασία χωρίζεται σε έξι κεφάλαια (συμπεριλαμβανομένου και της 
εισαγωγής). Ειδικότερα, το πρώτο κεφάλαιο αποτελεί το εισαγωγικό κεφάλαιο της εργασίας. 

Εν συνεχεία, στο δεύτερο κεφάλαιο γίνεται μια εκτενείς αναφορά στις νέες τεχνολογίες στην 
υπηρεσία της διαφήμισης, στο e-marketing, στις λειτουργίες e-marketing, στις μεθόδους 
προώθησης e-marketing, καθώς επίσης και στην χρήση των νέων τεχνολογιών στις 
επιχειρήσεις τουρισμού και κρουαζιέρας.  

Στο τρίτο κεφάλαιο δίνονται οι ορισμοί του τουρισμού και των πολυμέσων, αναφέρονται τα 
δομικά στοιχεία των πολυμέσων καθώς επίσης και παραδείγματα εφαρμογής πολυμέσων 
στον τουρισμό. 

Ακολούθως, στο τέταρτο κεφάλαιο γίνεται αναφορά στο πρόγραμμα Matchware Mediator 9 
και στα χαρακτηριστικά του. 

Στο πέμπτο κεφάλαιο αναφέρονται όλα τα βήματα δημιουργίας της πολυμεσικής 
εφαρμογής, όπως η δημιουργία και διαχείριση σελίδων, η δημιουργία και διαχείριση 

http://www.katakolo.info/el/
http://www.kotsanas.com
http://www.kotsanas.com/mousika.php
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αντικειμένων, καθώς επίσης και αναφορά στο λογισμικό επεξεργασίας βίντεο Windows 
Movie Maker.  

Τέλος, στο έκτο και τελευταίο κεφάλαιο γίνεται η παρουσίαση της ολοκληρωμένης 
εφαρμογής μέσα από εικόνες και επεξηγηματικά κείμενα.   
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2. ΟΙ ΝΕΕΣ ΤΕΧΝΟΛΟΓΙΕΣ ΣΤΗΝ ΥΠΗΡΕΣΙΑ ΤΗΣ 
ΔΙΑΦΗΜΙΣΗΣ  

 

2.1 ΗΛΕΚΤΡΟΝΙΚΟ ΜΑΡΚΕΤΙΝΓΚ  
Το Ηλεκτρονικό marketing ή E- marketing ή Διαδικτυακό marketing, είναι το μάρκετινγκ 
προϊόντων και υπηρεσιών που παρέχεται στο χώρο του Internet. Η ανάπτυξη του διαδικτύου 
ωφέλησε το μάρκετινγκ το οποίο χρησιμοποιεί την τεχνολογία της πληροφορικής με σκοπό 
την αύξηση της αποδοτικότητας, δημιουργώντας επιχειρηματικά μοντέλα που αυξάνουν την 
αξία για τον πελάτη και δίνουν περισσότερα κέρδη για την επιχείρηση. Η συγκεκριμένη 
μορφή μάρκετινγκ αποτελεί ένα νέο χώρο επικοινωνίας, με ιδιαίτερα ευρηματικές μεθόδους 
προσέλκυσης καταναλωτών σε παγκόσμιο επίπεδο, δίχως να χρειάζεται να περιορίζεται σε 
τοπικούς πελάτες. Οι μέθοδοι προσέλκυσης πελατών είναι στην πλειοψηφία τους πρωτότυπες 
και προσαρμοσμένες στη σύγχρονη ηλεκτρονική εποχή. 

Σε μία προσπάθεια ορισμού του e- Marketing θα λέγαμε ότι περιλαμβάνει τη χρήση 
ηλεκτρονικών δεδομένων και εφαρμογών για τον σχεδιασμό και την υλοποίηση: 

· της σύλληψης της επιχειρηματικής ιδέας για νέα αγαθά, υπηρεσίες ή ιδέες 
· της διανομής 
· της προβολής και 
· της τιμολόγησης των νέων αυτών αγαθών, υπηρεσιών ή ιδεών, με σκοπό να 

δημιουργηθούν ανταλλαγές οι οποίες θα ικανοποιούν αμοιβαία τους σκοπούς 
τόσο των αγοραστών όσο και της επιχείρησης. (Διαμαντάκης, 2011) (Πανταζή, 
2016).  

 

 

2.2 ΜΙΓΜΑ MARKETING    
Το μίγμα Marketing (marketing mix) είναι ένα σύστημα στενά συνδεδεμένων μεταβλητών 
που σχεδιάστηκαν για να ικανοποιούν τις ανάγκες των καταναλωτών – πελατών και τους 
στόχους της επιχείρησης. Συνδυάζει το ανθρώπινο δυναμικό και τα υλικά μέσα που 
χρησιμοποιεί η επιχείρηση για να επιτύχει τους στρατηγικούς της στόχους σε μία αγορά. 

Γνωρίζοντας τις συνθήκες της αγοράς, η εκάστοτε επιχείρηση μπορεί να επιλέξει τα 
τμήματα εκείνα της αγοράς που είναι ελκυστικά για την επιχείρηση, δηλαδή να επιλέξει την 
«αγορά στόχο». Αυτό σημαίνει ότι η επιχείρηση έχει την αντίληψη για : 

· τα χαρακτηριστικά των ατόμων ή των επιχειρήσεων που επιθυμεί να γίνουν 
πελάτες 
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· τη φύση των αναγκών που θα ικανοποιήσει με τα προϊόντα και τις υπηρεσίες που 
θα προσφέρει 

· τα χαρακτηριστικά των προϊόντων και των υπηρεσιών που θα θελήσουν οι 
μελλοντικοί πελάτες της επιχείρησης 

  Οπότε η επιχείρηση μπορεί να πάρει αποφάσεις για: 

· τα προϊόντα ή τις υπηρεσίες που θα προσφέρει 
· την πολιτική τιμών που θα ακολουθήσει 
· τη μέθοδο διανομής και τα σημεία πώλησης 
· τις μεθόδους προώθησης πωλήσεων προϊόντων ή υπηρεσιών  

Οι μεταβλητές αυτές είναι γνωστές ως τα 4 P’s όπου και πήραν το όνομά τους από τις 
τέσσερις αντίστοιχες λέξεις στα αγγλικά: 

· Προϊόν (Product) 
· Τιμή (Price) 
· Διανομή (Place) 
· Προώθηση (Promotion) 

 (Διαδραστικά Σχολικά Βιβλία, n.d.), (Διαμαντάκης, 2011), (Πανταζή, 2016) 

 

 
Εικόνα 1: 4 P’s Marketing (Amanios, 2012) 

 

· Προϊόν (Product) 
Αφορά τον προσδιορισμό, την επιλογή και τη ανάπτυξη του προϊόντος ή της 
υπηρεσίας με στόχο την ικανοποίηση των αναγκών του καταναλωτή. Μερικά από τα 
κύρια στοιχεία που διαμορφώνουν την πολιτική του προϊόντος είναι ποιότητα, το 
εμπορικό σήμα – μάρκα, η συσκευασία κτλ. 

· Τιμή (Price) 
Στην έννοια της τιμής περιλαμβάνεται αυτό που πρέπει να δώσει ο καταναλωτής έτσι 
ώστε να αποκτήσει το προϊόν ή την υπηρεσία που επιθυμεί. Αφορά τον καθορισμό 
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των τιμών και της τιμολογιακής πολιτικής, έχοντας ως γνώμονα τις προσδοκίες του 
καταναλωτή, τον ανταγωνισμό και το κόστος παραγωγής. 

· Διανομή (Place) 
Ως διανομή περιγράφεται ο τρόπος, μέσω του οποίου φτάνει το προϊόν στον 
καταναλωτή. Αφορά την επιλογή όλων των μεθόδων διανομής τον προϊόντων ώστε οι 
καταναλωτές να έχουν πρόσβαση στο προϊόν όπου και όποτε το ζητήσουν εύκολα και 
γρήγορα. 

· Προώθηση (Promotion) 
Αφορά την ανάπτυξη και την εφαρμογή στρατηγικής προώθησης, καθώς επίσης και 
το σύνολο των καναλιών και των εργαλείων ώστε να καταστεί αποτελεσματική η 
επικοινωνία με τον καταναλωτή.  (Promotion 3e, 2011)  
 

 

2.2.1 ΤΑ ΕΠΙΠΛΕΟΝ ΤΡΙΑ P’S (EXTENDED MIX MARKETING) 

Στα τέλη της δεκαετίας του ΄70 έγινε ευρέως αποδεκτό από τους εμπόρους ότι το μίγμα 
μάρκετινγκ πρέπει να ανανεωθεί. Αυτό οδήγησε στην δημιουργία του Extended Mix 
Marketing το 1981 από τους Booms & Bitner, οι οποίοι πρόσθεσαν τρία νέα στοιχεία στα ήδη 
υπάρχοντα 4P’s. Με αυτό τον τρόπο συμπεριλήφθησαν και προϊόντα που είναι υπηρεσίες και 
όχι μόνο φυσικά πράγματα.  

Τα επιπλέον τρία στοιχεία είναι: 

· Οι άνθρωποι (People) 
· Οι διαδικασίες (Procedures) 
· Το περιβάλλον της επιχείρησης (Physical evidence) 

 (Professional Academy, n.d.) 

 

Οι άνθρωποι (People) 

Αποτελούν σημαντικό στοιχείο του μίγματος μάρκετινγκ και συνδέονται άμεσα με την 
προσφορά υπηρεσιών. Για παράδειγμα, οι υπηρεσίες που προσφέρει μία τράπεζα ή ένα 
κατάστημα συνδέεται με την εξυπηρέτηση που θα λάβει ο πελάτης από τον υπάλληλο ή από 
οποιονδήποτε άλλο έρχεται σε άμεση ή έμμεση επαφή με τον πελάτη. 

 

Οι διαδικασίες (Procedures)  

Η φύση των διαφόρων διαδικασιών, ο βαθμός πολυπλοκότητάς τους και ο χρόνος που 
απαιτείται για την ολοκλήρωση τους αποτελούν επίσης σημαντικά στοιχεία του μίγματος 
Μάρκετινγκ. Για παράδειγμα η μεταφορά χρηματικών ποσών από ένα τραπεζικό λογαριασμό 
σε κάποιον άλλο μπορεί να γίνει με επίσκεψη στο τραπεζικό κατάστημα κατά τις εργάσιμες 
ώρες ή μέσω Α.Τ.Μ τηλεφώνου ή ηλεκτρονικού υπολογιστή από το γραφείο ή το σπίτι του 
πελάτη χωρίς αυτός να πρέπει να επισκεφθεί την τράπεζα. Όσα τραπεζικά καταστήματα 
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προσφέρουν τους προαναφερθείσες τρόπους τραπεζικών συναλλαγών παρέχουν καλύτερης 
ποιότητας εξυπηρέτησης στους πελάτες τους. 

 

Το περιβάλλον της επιχείρησης (Physical evidence)        

Το περιβάλλον στο οποίο λειτουργεί μια επιχείρηση προσφοράς υπηρεσιών όπως ένα 
ξενοδοχείο, εστιατόριο, πολυκατάστημα κλπ., ο τρόπος που είναι διακοσμημένη εσωτερικά 
και εξωτερικά, η λειτουργικότητα καθώς επίσης και η ασφάλεια και η υγιεινή των χώρων της 
είναι επίσης συνδεδεμένα με την ποιότητα των προσφερόμενων υπηρεσιών. Κατά συνέπεια 
και αυτό το στοιχείο συμπεριλαμβάνεται στο μίγμα Μάρκετινγκ των υπηρεσιών. 

Με την προσθήκη των τριών στοιχείων που προαναφέρθηκαν, το σύνολο των στοιχείων του 
μίγματος Μάρκετινγκ στην περίπτωση των υπηρεσιών ανέρχεται στα επτά. (Πανταζή, 2016) 
(Τσούτσης, Κανέλλος, & Κούτσης, 2009) 

 

2.3 ΛΕΙΤΟΥΡΓΙΕΣ E - MARKETING     
Το E – Marketing μέσω του διαδικτύου εκτός από την αύξηση των πωλήσεων και τη μείωση 
του κόστους μπορεί να εκπληρώσει κι άλλες λειτουργίες, όπως: 

· Έρευνα αγοράς: είναι η συλλογή και επεξεργασία πληροφοριών μέσω online 
ερωτηματολογίων, οι οποίες θα εξασφαλίσουν στον επιχειρηματία ικανοποιητική 
βάση για τη λήψη αποφάσεων (καθορισμός αναγκών, ανάλυση ανταγωνιστών). 

· Ανάπτυξη προϊόντων: Δημιουργία νέου προϊόντος ή μετατροπή παλαιότερου ώστε 
να καλύπτει υπάρχουσες ή μελλοντικές ανάγκες. Τα δεδομένα προέρχονται από 
μέτρηση αντιδράσεων των καταναλωτών για τα προϊόντα, λειτουργία 
παραπληροφόρησης, δοκιμαστική κυκλοφορία κτλ. 

· Εισαγωγή νέου προϊόντος, δοκιμή προϊόντος 
· Διαφοροποίηση, αλλαγή προϊόντος βάσει επανατροφοδότησης πληροφοριών από 

τους καταναλωτές (customer feedback)  
· Αναβάθμιση της εικόνας/image του προϊόντος της επιχείρησης  
·  Προσέλκυση της προσοχής του ενδιαφέροντος και ανάπτυξη της αγοραστικής 

πρόθεσης του πελάτη με την παρουσίαση των αναγκαίων πληροφοριών και των 
συγκριτικών πλεονεκτημάτων για τα προϊόντα 

· Υποστήριξη του πελάτη πριν την πώληση (ενημέρωση μέσω διαδικτύου) 
·  Υποστήριξη του πελάτη μετά την πώληση (επίλυση προβλημάτων, συνεχής 

παροχή υπηρεσιών σέρβις) 
· Δυνατότητα πρόσβασης από όλο τον κόσμο (Διαμαντάκης, 2011), (Πανταζή, 

2016) 
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2.4 ΠΛΕΟΝΕΚΤΗΜΑΤΑ E - MARKETING    
Το e-marketing είναι ένα επαναστατικό εργαλείο στον χώρο της επιχειρηματικότητας, των 
πωλήσεων και της διαφήμισης και παρουσιάζει αρκετά πλεονεκτήματα που αφορούν στην 
λειτουργία και στην απόδοση της επιχείρησης αλλά και στον ίδιο τον πελάτη. Παρακάτω 
περιγράφονται αναλυτικά τα πιο σημαντικά πλεονεκτήματα της εφαρμογής του e-marketing: 

· Άμεση επικοινωνία με τους πελάτες: Μέσα από ελκυστικές και καλά δομημένες 
παρουσιάσεις των προϊόντων και των υπηρεσιών, ο πελάτης μπορεί να έχει άμεσα και 
οποιαδήποτε στιγμή μια ολοκληρωμένη εικόνα για ότι τον ενδιαφέρει. 

· Οι πρακτικές του e-marketing προσφέρουν μεγαλύτερη ευελιξία προσαρμογής της 
επιχείρησης στις αλλαγές της αγοράς (αλλαγή τιμών, καθορισμός βραχυχρόνιων 
προσφορών, δοκιμές προϊόντων κλπ.) σε σχέση με τις παραδοσιακές. Η ενημέρωση 
των στοιχείων σε μια ηλεκτρονική σελίδα είναι εύκολη και γρήγορη, λόγω της φύσης 
του μέσου. Οι υπηρεσίες μάρκετινγκ μπορούν να αποδοθούν πολύ πιο γρήγορα από 
τις παραδοσιακές μεθόδους. Παράδειγμα, είναι το ¨κατέβασμα¨ (downloading) ενός 
φυλλαδίου με εξειδικευμένα με εξειδικευμένα προϊόντα καθώς επίσης και 
πληροφορίες για την εταιρεία όπως ετήσιες αναφορές ή δελτία τύπου. 

· Δυνατότητα όλων των επιχειρήσεων ανεξαρτήτου μεγέθους, να απευθυνθούν 
στην παγκόσμια αγορά: Δυνατότητα προώθησης των προϊόντων ή των υπηρεσιών σε 
ολόκληρο τον κόσμο. Έτσι, η έρευνα αγοράς απευθύνεται σε διευρυμένες περιοχές 
μικρότερων ή μεγαλύτερων γεωγραφιών. 

· On line και just in time εξυπηρέτηση των πελατών: Επιτρέπει την διαχείριση των 
αποθεμάτων μέσω του συστήματος διαχείρισης just in time (αυτό συνεπάγεται μείωση 
του κόστους αποθεμάτων). 

· On line συνεργασία με άλλες επιχειρήσεις: Τα μέσα του e-marketing μπορούν να 
χρησιμοποιηθούν για business to business (b2b) marketing. Το δίκτυο διανομής, οι 
μεσάζοντες, οι αντιπρόσωποι, οι πωλητές μπορούν να επικοινωνούν καθημερινά και 
να ζητούν πληροφορίες για τα προϊόντα. 

· Δυνατότητα άμεσης επικοινωνία με προμηθευτές 
· Δυνατότητα άμεσης παρακολούθησης των ανταγωνιστικών προϊόντων  
· Επιτρέπει την εξυπηρέτηση μιας μεγάλης πελατειακής βάσης 24 ώρες το 24ωρο σε 

αντίθεση με τη μέθοδο φυσικής διανομής που έχει τόσο αριθμητικούς όσο και 
χρονικούς περιορισμούς (π.χ. ωράριο καταστημάτων). 

· Δυνατότητα εφαρμογής relationship marketing: Αύξηση της αφοσίωσης του 
πελάτη και αναβάθμιση της επικοινωνίας επιχείρησης-καταναλωτή. 

· Προσφέρουν σημαντικές οικονομίες κλίμακας: (π.χ. μειωμένο κόστος συναλλαγών) 
με αποτέλεσμα το χαμηλότερο κόστος προϊόντος και μικρότερους χρόνους 
παράδοσης. 

· Είναι φτηνό: Η προώθηση της επιχείρησης εξαρτάται από το πλάνο και το budget του 
επιχειρηματία. Επίσης δεν χρειάζεται τεράστια ποσά για την δημιουργία των 
διαφημίσεων καθώς υπάρχουν επιλογές τόσο για χαμηλά όσο και υψηλά budget. 
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· Είναι γρήγορο: Με το e-marketing ο επιχειρηματίας μπορεί να ετοιμάσει μια 
διαφημιστική εκστρατεία μέσα σε 30 λεπτά και να αρχίσει να λαμβάνει επισκέπτες-
πιθανούς πελάτες την επόμενη κιόλας ημέρα. 

· Είναι στοχευμένο: με το e-marketing υπάρχει δυνατότητα στοχευμένης διαφήμισης 
σε συγκεκριμένα άτομα μέσω της αναζήτησης που πραγματοποιούν στις μηχανές 
αναζήτησης (π.χ. Google), στα social media (π.χ. Facebook), καθώς επίσης και μέσα 
από ιστοσελίδες που στοχεύουν συγκεκριμένες κατηγορίες κοινού. (Πιτσαδιώτη, 
2015), (Βασίλου, 2014), (Giorkas , 2014). 

 

 

  2.5 ΣΤΡΑΤΗΓΙΚΟΣ ΣΧΕΔΙΑΣΜΟΣ E - MARKETING    
Η σημαντικότερη ενέργεια για κάθε επιχείρηση είναι ο προγραμματισμός. Ο στρατηγικός 
προγραμματισμός προσδιορίζει τι θα πραγματοποιηθεί στο μέλλον δηλαδή τον τόπο, τον 
τρόπο και τα μέσα εκτέλεσης του έργου. Σε περίπτωση που κάποιο από τα στοιχεία δεν 
ληφθεί υπόψη από την αρχή, είναι πολύ πιθανό η επιχείρηση να έχει μια λάθος επένδυση είτε 
όσον αφορά το ίδιο το προϊόν, είτε την τιμή του είτε τον τρόπο διανομής ή τον τρόπο 
προώθησης. 

Για μια επιτυχημένη παρουσία και δραστηριότητα της επιχείρησης στο Internet, ο 
στρατηγικός σχεδιασμός marketing προϋποθέτει την ύπαρξη ορισμένων βημάτων: 

 

· Ο καθορισμός των στόχων της επιχείρησης 

Κάθε επιχείρηση θα πρέπει να καθορίσει από την αρχή τους στόχους της είτε πρόκειται για 
ηλεκτρονική επιχείρηση είτε όχι. Οι στόχοι όπου μπορεί να θέσει μια επιχείρηση είναι: 

· Η βελτίωση της εικόνας της επιχείρησης 
· Η βελτίωση της εξυπηρέτησης των πελατών της 
· Ο εντοπισμός νέων ευκαιριών 
· Η αύξηση της προβολής της στην αγορά 
· Η ανάπτυξη συναλλαγών 
· Η επέκταση σε νέες αγορές 
· Η προσαρμογή στις προσδοκίες των καταναλωτών 
· Η μείωση του κόστους marketing 
· Η υιοθέτηση νέων τεχνολογιών για τη διατήρηση του καινοτόμου 

χαρακτήρα της 

 

· Ο προσδιορισμός τεχνολογικής και τηλεπικοινωνιακής υποδομής της επιχείρησης. 
Συμβάλει στην επίτευξη των στόχων και στην εδραίωση της επιχείρησης στο 
διαδίκτυο. 

· Συλλογή πληροφοριών για την αγορά-στόχο σε σχέση με το κοινό του διαδικτύου. 
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· Κατάρτιση προϋπολογισμού και αξιολόγηση των περιβαλλοντικών παραγόντων για 
την εφαρμογή της στρατηγικής marketing σε θέματα νομικά, εκπαίδευσης και 
υποστήριξης. 

· Μελέτη των παραγόντων που αφορούν στο προϊόν ή στην υπηρεσία, στην τιμή, την 
προβολή καθώς και στις ιδιαιτερότητές του. (Σιώμκος, 2003, σ. 291), (Πανταζή, 
2016)  

 

Κάποια επιπλέον βήματα στρατηγικού σχεδιασμού e-marketing είναι: 

· Σχεδιασμός και υλοποίηση της ανάλυσης SWOT (Strengths Weaknesses 
Opportunities Threats) 

Εδώ εξετάζονται οι δυνάμεις και οι αδυναμίες που υπάρχουν στο εσωτερικό της 
επιχείρησης, καθώς επίσης εντοπίζονται και αναλύονται οι ευκαιρίες και οι απειλές του 
εξωτερικού περιβάλλοντος της επιχείρησης. 

 

· Καθορισμός ανταγωνιστικών ικανοτήτων 

Η επιχείρηση εντοπίζει τα σημεία όπου υπερέχει έναντι των ανταγωνιστών της, καθώς 
επίσης καθορίζει τα μέσα και τους τρόπους επίτευξης ανταγωνιστικού πλεονεκτήματος έναντι 
των άλλων επιχειρήσεων. 

 

· Καθορισμός ανταγωνιστικού χώρου δράσης 

Εντοπισμός ευκαιρίας για την ανάληψη επιχειρηματικής δράσης, καθώς και την φύση του 
ανταγωνιστικού περιβάλλοντος. (Πιτσαδιώτη, 2015) 

 

2.6 ΜΕΘΟΔΟΙ ΠΡΟΩΘΗΣΗΣ E-MARKETING    
Το e-marketing περιλαμβάνει όλους τους τρόπους με τους οποίους μπορεί κάποιος να 
προωθήσει και να διαφημίσει τα προϊόντα και τις υπηρεσίες του μέσω του internet, βοηθάει 
στην αύξηση της προβολής της επιχείρησης, στην προσέγγιση νέων πελατών, στην μείωση 
των λειτουργικών εξόδων, καθώς επίσης και στην αύξηση των εσόδων. Η επιχείρηση 
χρησιμοποιεί διάφορες μεθόδους και τεχνικές e-marketing, για να προσεγγίσει καταναλωτές 
όπως είναι η δημιουργία ιστοσελίδας, τα μέσα κοινωνικής δικτύωσης, η χρήση των banners 
κτλ. Οι πιο σημαντικές μέθοδοι προώθησης περιγράφονται πιο κάτω: 

 

· Δημιουργία Website 

Η δημιουργία ιστοσελίδας αποτελεί το πρώτο βήμα εισαγωγής στο e-marketing για μια 
επιχείρηση. Με την ιστοσελίδα η επιχείρηση έχει την δυνατότητα να προβάλει όλα τα 
προϊόντα και τις υπηρεσίες που διαθέτει, καθώς επίσης και τα χαρακτηριστικά της, με σκοπό 
την προσέλκυση νέων πελατών και την διατήρηση των παλιών πελατών.  
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Μέσω της ιστοσελίδας δίνεται η δυνατότητα στον επισκέπτη/πελάτη, η άμεση πώληση των 
προϊόντων της επιχείρησης μέσω internet, καθώς επίσης και η δυνατότητα επικοινωνίας των 
επισκεπτών/πελατών με τον υπεύθυνο διαχείρισης της ιστοσελίδας. Μια ιστοσελίδα είναι 
απαραίτητη ακόμα και για την πιο μικρή επιχείρηση διότι έχει χαμηλό κόστος κατασκευής.  

(Tampakas , 2018), (Βασίλου, 2014) 

  

· Banner Marketing ή Banner Advertising  

Τα banners είναι μικρά γραφικά εικονίδια τα οποία συνδέονται με τον διαδικτυακό τόπο του 
διαφημιζόμενου συνήθως επί πληρωμή. Τα banners είναι εικόνες σε σχήμα 
παραλληλόγραμμου που εμφανίζονται σε κάποια θέση της ιστοσελίδας στην οποία 
προβάλλονται. Τα banners προβάλουν το μήνυμα της κάθε επιχείρησης και ενισχύουν τα 
προϊόντα ή τις υπηρεσίες, προωθώντας τον χρήστη στην ιστοσελίδα για να μάθει σχετικά με 
την επιχείρηση. Τα χαρακτηριστικά που πρέπει να διαθέτουν τα banners για να πετύχουν το 
καλύτερο αποτέλεσμα είναι:  

Ø Να είναι διαδραστικά έτσι ώστε να προσελκύουν το κοινό 
Ø Το μήνυμα προς το κοινό να είναι ξεκάθαρο 
Ø Να έχουν πρωτότυπη σχεδίαση 
Ø Να ενδυναμώνουν την αναγνωρισημότητα της μάρκας, έτσι ώστε να 

αποτυπωθεί στο μυαλό του χρήστη  

Τα banners έχουν εξελιχθεί τόσο πολύ, ώστε να μπορούν να προβάλουν διαφημίσεις, να 
συγκεντρώνουν δημογραφικά στοιχεία και να αλληλεπιδρούν με τον επισκέπτη. Μέσω των 
banners μπορεί να ελεγχθεί ο αριθμός των ατόμων που τα βλέπει και τα επιλέγει. Ακόμα, 
μπορούν να προβληθούν διαφορετικά banners της ίδιας εταιρείας την ίδια χρονική περίοδο 
και να αποσυρθούν άμεσα όσα δεν επιλέγονται. Τα banners είναι ένας άμεσα μετρήσιμος 
τρόπος προώθησης. (Πανταζή, 2016), (Τσούτσης, Κανέλλος, & Κούτσης, 2009) 

 

· Affiliate Marketing (Συνεργατικό μάρκετινγκ) 

Το affiliate marketing είναι η πιο διαδεδομένη μέθοδος προβολής και αφορά μια συμφωνία 
μεταξύ δύο μερών (δύο επιχειρήσεων ή ιδιώτη και επιχείρησης) βάσει της οποίας ο affiliate 
(συνεργάτης) παραπέμπει από την ιστοσελίδα του, πελάτες στην ιστοσελίδα μιας άλλης 
επιχείρησης (της διαφημιζόμενης) με στόχο την προώθηση των προϊόντων ή των υπηρεσιών 
στο διαδίκτυο. Το affiliate marketing κατέχει περίοπτη θέση στη στρατηγική marketing των 
επιχειρήσεων που δραστηριοποιούνται στο ηλεκτρονικό εμπόριο. 

Ο όρος affiliate περιγράφει τη σχέση ανάμεσα στο διαφημιζόμενο και στον affiliate 
(συνεργάτη), κατά την οποία ο δεύτερος, με εργαλείο το διαδίκτυο προωθεί επισκέπτες στην 
ιστοσελίδα του πρώτου και πληρώνεται μόνο εφόσον οι επισκέπτες αυτοί πραγματοποιήσουν 
μια προσυμφωνημένη ενέργεια/συναλλαγή. Αυτός ο τρόπος πληρωμής λέγεται Cost per 
Action (CPA) και είναι αυτός που διαφοροποιεί το affiliate marketing από τις άλλες μεθόδους 
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προώθησης και διαφήμισης. Οι μέθοδοι ανταμοιβής που αφορούν το Affiliate Marketing 
περιγράφονται παρακάτω: 

Ø Cost per Action ή Cost per Lead (CPA ή CPL): ο έμπορος (merchant) 
ανταμείβει τον affiliate για μια πράξη που κάνει ο επισκέπτης μέσα από την 
ιστοσελίδα του, όπως πραγματοποίηση μιας αγοράς. 

Ø Cost per Click ή Pay per Click (CPC ή PPC): ο affiliate εισπράττει ένα 
μικρό ποσό για κάθε κλικ γίνεται στο διαφημιστικό banner όπου έχει 
τοποθετήσει στην ιστοσελίδα του, ανάλογα με την επισκεψιμότητα. Το CPC 
είναι ευρέως διαδεδομένο στο Search Engine Marketing (SEO). 

Ø Cost per Sale: για κάθε πώληση προϊόντος που γίνεται μέσω της σελίδας 
του affiliate, ο affiliate ανταμείβεται με ένα προσυμφωνημένο ποσοστό. 
Δηλαδή αν ένας επισκέπτης κάνει κλικ πάνω σε ένα banner της σελίδας του 
affiliate και στη συνέχεια επισκεφτεί ένα ηλεκτρονικό κατάστημα όπου και 
αγοράσει λ]κάποιο προϊόν, τότε ο affiliate που τοποθέτησε τη διαφήμιση 
στη σελίδα πληρώνεται με ένα ποσοστό από τη πώληση αυτή. 

Ø Revenue Sharing: Ο διαφημιζόμενος μοιράζεται ένα ποσοστό από τα κέρδη 
του με τον affiliate αντί να του δίνει ένα ποσοστό από το συνολικό ποσό της 
πώλησης. Χρησιμοποιείται στα τυχερά παιχνίδια. 

Ø Cost per Thousand (CPM): ο affiliate κερδίζει μια προμήθεια για κάθε 
χίλιες εμφανίσεις μιας διαφήμισης. (Βλαχοπούλου & Δημητριάδης, 2014, 
σσ. 204-208)     

 

· SEM (Search Engine Marketing)  

Το Search Engine Marketing αποτελεί μια προσπάθεια προώθησης ιστοσελίδων μέσω των 
μηχανών αναζήτησης. Οι μηχανές αναζήτησης βοηθούν στον εντοπισμό πληροφοριών ή 
ιστότοπων (URLS) που βρίσκονται στο διαδίκτυο μέσω κάποιον λέξεων-κλειδιών. Η πιο 
γνωστή μηχανή αναζήτησης είναι η Google. Κάθε ιστοσελίδα κατέχει μια συγκεκριμένη θέση 
στη λίστα αποτελεσμάτων αυξάνοντας τον ανταγωνισμό και δημιουργώντας το SEM. Το 
SEM προσφέρει καλύτερες θέσεις στα αποτελέσματα αναζήτησης μέσω τεχνικών 
προώθησης. 

Ο τρόπος που εμφανίζονται τα αποτελέσματα μια αναζήτησης αποτελούνται από δυο μέρη: 

Ø Το πρώτο μέρος που αποτελείται από ηλεκτρονικές διευθύνσεις οι οποίες 
εμφανίζονται σε σειρά και έχουν σχέση με την αναζήτηση που έχει κάνει ο 
χρήστης. Τα αποτελέσματα αυτά ονομάζονται οργανικά (organics search 
results) και η κατάταξή τους δεν μπορεί να αλλάξει. 

Ø Το δεύτερο μέρος είναι οι διαφημίσεις ιστότοπων (πληρωμένες 
καταχωρήσεις). Εμφανίζονται πάνω από τα οργανικά αποτελέσματα ή και 
στην κάθετη στήλη δεξιά. 

Το Search Engine Marketing αποτελεί ένα πολύ σημαντικό κομμάτι του internet marketing 
καθώς επίσης και την κύρια πηγή επισκεπτών στις ιστοσελίδες παγκοσμίως. Η εφαρμογή του 
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δεν κοστίζει ιδιαίτερα και μπορεί να έχει εντυπωσιακά αποτελέσματα. (Tampakas , 2018), 
(Πανταζή, 2016) 

 

 

· PPC (Pay Per Click) 

Αποτελεί μια από τις πιο διαδεδομένες ενέργειες του SEM (Search Engine Marketing), και 
αφορά τις πληρωμένες διαφημίσεις που εμφανίζονται σε ένα έντονο πλαίσιο στην κορυφή της 
σελίδας ή στα δεξιά της, όταν ο χρήστης πραγματοποιεί μια αναζήτηση. Οι διαφημίσεις αυτές 
ονομάζονται PPC (Pay Per Cost), και πήραν το όνομά τους από τον τρόπο που χρεώνεται ο 
διαφημιζόμενος. Στην PPC διαφήμιση ο διαφημιζόμενος χρεώνεται μόνο όταν κάποιος κάνει 
κλικ πάνω στην διαφήμιση του, η οποία εμφανίζεται στα αποτελέσματα αναζήτησης του 
χρήστη. (entertheweb, 2018), (Giorkas, 2014). 

 

· SEO (Search Engine Optimization) 

Μία ακόμα διαδεδομένη ενέργεια του SEM (Search Engine Marketing), είναι το SEO 
(Search Engine Optimization) που αφορά τεχνικές βελτιστοποίησης ιστοσελίδων για τις 
μηχανές αναζήτησης. Αφορά όλες τις απαραίτητες ενέργειες που πρέπει να γίνουν σε μια 
ιστοσελίδα, έτσι ώστε η κατάταξή της να είναι όσο το δυνατόν υψηλότερα στα αποτελέσματα 
των μηχανών αναζήτησης. Αυτό μπορεί να επιτευχθεί με τη χρήση συγκεκριμένων λέξεων-
κλειδιών (ορίζουν ή περιγράφουν το περιεχόμενο της σελίδας) που αναζητεί ο χρήστης. Η 
συγκεκριμένη τεχνική δημιουργεί μια μεγάλη ροή επισκεπτών στην σελίδα. (Tampakas , 
2018), (entertheweb, 2018) 

 

· SMM (Social Media Marketing) 

 
Εικόνα 2: Social Media (Nomad , n.d) 

 

Τo SMM (Social Media Marketing), αποτελεί μια μορφή μάρκετινγκ η οποία χρησιμοποιεί 
τα μέσα κοινωνικής δικτύωσης ως μέσο προβολής των προϊόντων και των υπηρεσιών που 
προσφέρει η κάθε επιχείρηση. Μερικά από τα πιο δημοφιλή κοινωνικά μέσα δικτύωσης είναι 
το Facebook, to Twitter, το Instagram, το YouTube κτλ. Μέσω αυτών δίνεται η δυνατότητα 
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στην επιχείρηση να προσεγγίσει το κοινό που την ενδιαφέρει και κατά συνέπεια 
περισσότερους υποψήφιους πελάτες. Απλοποιούν και βελτιώνουν την ταχύτητα και το εύρος 
διάδοσης των πληροφοριών. Μια επιχείρηση κάνοντας χρήση των κοινωνικών μέσων 
δικτύωσης δείχνει πιο προσιτή στο κοινό, προσφέροντας μια άμεση αλληλεπίδραση με τους 
πελάτες και τους υποψήφιους πελάτες μέσα από το διαδραστικό τους κομμάτι (μηνύματα, e-
mail). (Πανταζή, 2016), (Σαβαλάν, 2012). 

 

· E-mail Marketing 

Το e-mail marketing (μάρκετινγκ ηλεκτρονικού ταχυδρομείου) αποτελεί άμεσο μάρκετινγκ 
μέσω εμπορικού μηνύματος σε μια ομάδα ανθρώπων που χρησιμοποιούν το e-mail ως μέσο 
ενημέρωσης. Η συγκεκριμένη στρατηγική e-marketing επιτρέπει στον διαφημιζόμενο να 
κρατήσει επαφή με πελάτες που σε άλλη περίπτωση θα τους έχανε, αποστέλλοντας στο e-
mail τους διαφημίσεις σχετικά με τα προϊόντα της επιχείρησης με σκοπό την προσέλκυση 
νέων πελατών και την δημιουργία της εικόνας της επιχείρησης ως αξιόπιστη στα μάτια των 
νέων και των παλαιότερων πελατών της. 

 Για να επιτευχθούν όλα τα παραπάνω το e-mail που θα πρέπει να είναι της μορφής: 

Ø Newsletter: τα newsletter περιλαμβάνουν ενημέρωση με άρθρα και 
συμβουλές που περιλαμβάνουν θέματα γενικού τύπου τα οποία 
ενδιαφέρουν το κοινό. 

Ø Ενημερωτικών e-mail: τα συγκεκριμένα e-mail αναφέρονται σε 
συγκεκριμένα προϊόντα και υπηρεσίες που παρέχει η επιχείρηση. Το 
περιεχόμενο τους πρέπει να είναι στοχευμένο και να οδηγούν τους 
αναγνώστες σε κάποια ενέργεια όπως για παράδειγμα να κατεβάσουν ένα 
αρχείο. 

Ø Διαφημιστικών e-mail: αυτά τα e-mail περιλαμβάνουν προσφορές 
προϊόντων, εκπτωτικά κουπόνια, δώρα με στόχο την αύξηση των 
πωλήσεων. 

Το e-mail marketing δίνει την δυνατότητα σε όλα ρα websites να δημιουργήσουν μια λίστα 
από e-mail addresses και να έχουν επικοινωνία με υποψήφιους πελάτες όποτε το επιθυμούν. 
Η δημιουργία μιας e-mail λίστας είναι το μυστικό της επιτυχίας στο e-marketing και μια 
αξιόπιστη στρατηγική. (Tampakas , 2018), (Πιτσαδιώτη, 2015). 

 

2.7 ΧΡΗΣΗ ΝΕΩΝ ΤΕΧΝΟΛΟΓΙΩΝ ΣΕ ΕΠΙΧΕΙΡΗΣΕΙΣ ΤΟΥΡΙΣΜΟΥ ΚΑΙ 
ΚΡΟΥΑΖΙΕΡΑΣ   
Οι Τεχνολογίες Πληροφορίας και Επικοινωνών (ΤΠΕ) είναι ένας τομέας εφαρμογών 
ποικίλων επιστημονικών τομέων. Αναφέρονται σε κάθε μορφής ψηφιακό μέσο, το οποίο 
μπορεί να χρησιμοποιηθεί αυτόνομα ή ως στοιχείο ενός τεχνολογικού συστήματος, για την 
αναζήτηση, την πρόσβαση, την επεξεργασία, την παραγωγή, την διαμόρφωση και την 
παρουσίαση της πληροφορίας. Ακόμα, χρησιμοποιείται για την καταχώρηση, τη συλλογή, την 
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ανάλυση, την αναπαράσταση και τη διακίνηση (μετάδοση, ανταλλαγή) των πληροφοριών. 
Συγκεκριμένα γίνετε αναφορά στις υπολογιστικές και δικτυακές τεχνολογίες, οι οποίες την 
τελευταία δεκαετία αποσαφήνισαν τον όρο Νέες τεχνολογίες (ΝΤ), που προηγήθηκε, ο οποίος 
με τη σειρά του εμφανίστηκε ως η πιο νεωτεριστική, επαναστατική εκδοχή της 
Εκπαιδευτικής τεχνολογίας. (Ζαμπουλάκης, 2014). 

 

 

2.7.1 ΧΡΗΣΗ ΝΕΩΝ ΤΕΧΝΟΛΟΓΙΩΝ ΣΕ ΕΠΙΧΕΙΡΗΣΕΙΣ ΤΟΥΡΙΣΜΟΥ    

Οι Τεχνολογίες Πληροφορικής και Επικοινωνιών (ΤΠΕ), εφαρμόζονται από τις επιχειρήσεις 
τουρισμού με την χρήση των Μηχανογραφημένων Συστημάτων Κρατήσεων (Computer 
Reservation Systems - CRS) και των Παγκόσμιων Συστημάτων Διανομής (Global 
Distribution Systems - GDS.). 

 

· Μηχανογραφημένα Συστήματα Κρατήσεων ( Computer Reservation Systems 
– CRS) 
Τα Μηχανογραφημένα Συστήματα Κρατήσεων (CRS), είναι από τα πιο βασικά 
συστήματα καθώς διευκολύνουν τη συνεργασία των τουριστικών επιχειρήσεων και 
των τουριστών. Τα συστήματα αυτά υποστηρίζουν τις ταξιδιωτικές συναλλαγές 
που πραγματοποιούνται ηλεκτρονικά, καθώς επίσης επεξεργάζονται και παρέχουν 
πληροφορίες για το τουριστικό προϊόν. Τα συστήματα ηλεκτρονικών κρατήσεων, 
είναι βάσεις δεδομένων οι οποίες επιτρέπουν στις τουριστικές επιχειρήσεις να 
διαχειρίζονται τα δεδομένα τους και να τα διαθέτουν στα κανάλια διανομής των 
συνεργατών τους. 
Στο κορμό της τουριστικής βιομηχανίας εντάσσονται επιχειρήσεις οι οποίες 
λειτουργούν και δραστηριοποιούνται μέσω του διαδικτύου, όπως οι ξενοδοχειακές 
μονάδες, οι αεροπορικές εταιρείες, οι επιχειρήσεις που μισθώνουν μέσα μαζικής 
μεταφοράς (αυτοκίνητα, ποδήλατα) κλπ. Οι επιχειρήσεις αυτές κατέχουν 
Μηχανογραφημένα Συστήματα Κρατήσεων, καθώς οι συναλλαγές 
πραγματοποιούνται σε πραγματικό χρόνο (ή σε σχετικά πραγματικό χρόνο), 
δίνοντας τη δυνατότητα στους χρήστες του συστήματος να σχεδιάσουν και να 
οργανώσουν τις διακοπές τους νωρίτερα από τη προγραμματισμένη περίοδο 
αναχώρησης τους. 
Η ανάπτυξη των CRS οφείλεται κυρίως στις αεροπορικές εταιρείες ενώ 
ακολούθησαν οι μεγάλοι ξενοδοχειακοί όμιλοι και οι υπόλοιπες τουριστικές 
επιχειρήσεις. Τα συστήματα CRS παρέχουν την δυνατότητα της έκδοσης 
εισιτηρίων καθώς και της εμφάνισης της διαθεσιμότητας των κρατήσεων και τον 
υπολογισμό των ναύλων. 
Η επιλογή ενός συστήματος CRS από ένα τουριστικό πρακτορείο εξαρτάται από 
τις εταιρείες που συνεργάζεται. Πολλά πρακτορεία συνδέονται με περισσότερα 
από ένα συστήματα κρατήσεων. Σημαντικοί παράγοντες για την επιλογή ενός 
συστήματος είναι η έγκυρη πληροφόρηση, η αξιοπιστία του υλικού εξοπλισμού 
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τους, η γρήγορη υποστήριξη και εξυπηρέτηση, καθώς και η εύκολη χρήση του 
συστήματος. 
Με τη χρήση των CRS ο καταναλωτής-τουρίστας αποκομίζει σημαντικά οφέλη τα 
οποία του παρέχουν πραγματοποίηση κρατήσεων εύκολα, γρήγορα, αξιόπιστα και 
εγγυημένα καθώς επίσης και δυνατότητα πρόσβασης σε μεγάλο όγκο δεδομένων-
πληροφοριών. (Μουτζούρη, 2012), (Βασιλάκη, Ορφανού, & Ρουμελιώτη, 2016) 
 
 

· Παγκόσμια Συστήματα Διανομής (Global Distribution Systems – GDS)   
Η μεγάλη συνεργασία μεταξύ των διάφορων C.R.S οδήγησε στη μετεξέλιξη τους 
σε Παγκόσμια Συστήματα Διανομής (Global Distribution Systems – GDS). Τα 
συστήματα αυτά στην ουσία είναι ο μεσάζοντας μεταξύ των ταξιδιωτικών 
πρακτορείων και των τουριστικών επιχειρήσεων (ξενοδοχειακές επιχειρήσεις, 
αεροπορικές εταιρείες, εταιρείες ενοικίασης αυτοκινήτων κλπ). Τα GDS 
επεξεργάζονται ταξιδιωτικές συναλλαγές, διανέμουν διάφορες τουριστικές 
πληροφορίες, καθώς επίσης διασφαλίζει την κράτηση μέσα σε ελάχιστο χρόνο, 
επιταχύνοντας έτσι τον χρόνο εξυπηρέτησης.  
Τα GDS περιλαμβάνουν έναν μεγάλο αριθμό επιχειρήσεων, όπου ο τουρίστας έχει 
τη δυνατότητα να κάνει κράτηση όπου επιθυμεί. Με τη χρήση των συστημάτων 
αυτών υπάρχει η δυνατότητα πώλησης και διανομής τουριστικών προϊόντων και 
υπηρεσιών παγκοσμίως.  
Ορισμένα από τα πλεονεκτήματα που επέφερε η ψηφιοποίηση των συστημάτων 
GDS όσον αφορά τις επιχειρήσεις και τους καταναλωτές είναι η οικονομική και 
άμεση μετάδοση πληροφοριών σε όλα τα σημεία πώλησης, η αύξηση των σημείων 
πώλησης σε διεθνές επίπεδο και η μείωση των λειτουργικών εξόδων των 
τουριστικών φορέων. Ακόμα, εξυπηρετούν την πώληση και την προβολή 
προϊόντων αεροπορικών εταιριών, επιχειρήσεων ενοικίασης αυτοκινήτων, 
ξενοδοχειακών επιχειρήσεων, ασφαλιστικών και σιδηροδρομικών εταιρειών καθώς 
και εταιρειών ακτοπλοΐας. Ο καταναλωτής μέσω της χρήσης των νέων 
τεχνολογιών (διαδίκτυο, κινητό τηλέφωνο κλπ.),  μπορεί να έχει άμεση πρόσβαση 
στα συστήματα GDS δίχως να εξαρτάται από τους τουριστικούς πράκτορες.  
Οι δυνατότητες που προσφέρουν τα GDS στους χρήστες τους, είναι παροχή 
τουριστικών πληροφοριών για οποιοδήποτε ταξίδι επιθυμούν να 
πραγματοποιήσουν, ο υπολογιστής των ναύλων, οι κρατήσεις και η εμφάνιση 
διαθεσιμότητας πτήσεων και θέσεων. Ακόμα, πραγματοποιείται η έκδοση 
εισιτηρίων και η πρόσβαση σε πληροφορίες για κανονισμούς που αφορούν την 
visa, το διαβατήριο και τις τιμές συναλλάγματος.  
Τα κυριότερα Παγκόσμια Συστήματα Διανομής (GDS) είναι Amadeus, Galileo 
International, Sabre και Worldspan. (Μουτζούρη, 2012), (Βασιλάκη, Ορφανού, & 
Ρουμελιώτη, 2016). 
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2.7.2 ΧΡΗΣΗ ΝΕΩΝ ΤΕΧΝΟΛΟΓΙΩΝ ΣΕ ΕΠΙΧΕΙΡΗΣΕΙΣ ΚΡΟΥΑΖΙΕΡΑΣ  

Η βιομηχανία της κρουαζιέρας αναπτύσσετε με γρήγορους ρυθμούς έχοντας σύμμαχο της 
την τεχνολογία. Τα επόμενα πέντε χρόνια, η κρουαζιέρα θα αποτελεί ένα ταξίδι όπου οι 
πελάτες θα είναι συνδεδεμένοι με το ταξίδι και δεν θα υπάρχει κανένας βαθμός αναμονής. 
Τον περασμένο χρόνο μια από τις κορυφαίες εταιρείες κρουαζιέρας η Carnival Corporation, 
ανακοίνωσε πως έχει υιοθετήσει νέες τεχνολογίες οι οποίες υπόσχονται να μετατρέψουν το 
ταξίδι της κρουαζιέρας σε μια λιγότερο δυσάρεστη εμπειρία. Το μεγαλύτερο μέρος 
περιλαμβάνει τεχνολογίες ενσωματωμένης αναγνώρισης προσώπου και γεωγραφικής θέσης. 
Στη συνέχεια περιγράφεται η νέα καινοτομία τεχνολογικής εξέλιξης της εταιρείας Carnival 
Corporation. (Chabeli Herrera, 2017)  

 

· Ocean Medallion  

Η εταιρεία Carnival Corporation κατέχει την πρώτη θέση στην εξέλιξη των νέων 
τεχνολογιών. Η εταιρεία κρουαζιέρας Doral ήταν η πρώτη που αποκάλυψε τα σχέδια της για 
μια ολόκληρη σειρά τεχνολογικών εξελίξεων που θα μετατρέψουν τα πλοία του στόλου της 
σε έξυπνα. Τον Ιανουάριο του 2018, η εταιρεία Carnival Corporation αποκάλυψε το 
αποτέλεσμα ενός 18μηνου έργου που έχει ως στόχο να κάνει την εμπειρία της κρουαζιέρας 
πιο διαισθητική.  

Αντί να εξαρτάται σε μεγάλο βαθμό από ένα έξυπνο τηλέφωνο, η εταιρεία Carnival επέλεξε 
να κατασκευάσει ένα "μενταγιόν", το "Ocean Medallion". Το μενταγιόν είναι ένας μικρός 
δίσκος που ζυγίζει λίγο λιγότερο από δυο ουγγιές και περιέχει πληροφορίες σχετικά με τον 
επιβάτη, όπως το όνομα του, την ημερομηνία αναχώρησης, το όνομα του πλοίου και 
υπηρεσίες ενσωμάτωσης εντοπισμού γεωγραφικής τοποθεσίας. Αντικαθιστά το κλειδί της 
καμπίνας των επιβατών. Οι επισκέπτες μπορούν να το μεταφέρουν είτε μόνο του στις τσέπες 
τους, ή σε ένα βραχιόλι ή σε ένα μενταγιόν με επιπλέον κόστος.  

 

 
Εικόνα 3: "Ocean Medallion" σε βραχιόλι της Carnival Corporation (Chabeli Herrera, 

2017)  
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Το μενταγιόν αλληλεπιδρά με ολόκληρο το πλοίο, στο οποίο έχουν εγκατασταθεί χιλιάδες 
αισθητήρες και διαδραστικές οθόνες. Για παράδειγμα, καθώς οι επισκέπτες προσεγγίζουν τις 
πόρτες τους, οι αισθητήρες που βρίσκονται στην πόρτα αναγνωρίζουν το μενταγιόν και οι 
πόρτες ξεκλειδώνουν αυτόματα. Χάρη στο μενταγιόν, ένας ψηφιακός τοίχος φωτογραφιών 
αισθάνεται την προσέγγιση του επιβάτη, και προσαρμόζεται και αυτόματα απεικονίζει 
στιγμές του επιβάτη από τις διακοπές του στην κρουαζιέρα. Όταν ένας επιβάτης παραγγείλει 
ένα ποτό είτε σε μία διαδραστική οθόνη, ή σε ένα έξυπνο τηλέφωνο ή σε κάποια άλλη 
συσκευή, το πλήρωμα μπορεί να εντοπίσει τον επιβάτη, οπουδήποτε κι αν βρίσκεται στο 
πλοίο λόγω της τεχνολογίας εντοπισμού θέσης που είναι ενσωματωμένη στο μενταγιόν.  

Το λειτουργικό σύστημα πίσω από το μενταγιόν είναι η εφαρμογή Ocean Compass, ένα 
online προφίλ διακοπών, όπου ο επιβάτης δημιουργεί πριν από το ταξίδι του με το πλοίο, 
όπου καταχωρεί τις προτιμήσεις του. Κατά την διάρκεια του ταξιδιού μπορούν να 
προσθέτουν πληροφορίες μέσω ενσωματωμένων οθονών και προσωπικών συσκευών. Ακόμα, 
το πλήρωμα μπορεί να έχει πρόσβαση στο προφίλ των επιβατών στην εφαρμογή Ocean 
Compass, επιτρέποντας τους να προσφέρουν σχετικές προτάσεις και να απευθύνονται στους 
επιβάτες με το όνομα τους.  

 
Εικόνα 4: "Ocean Medallion" της Carnival Corporation μαζί με το συνοδευτικό λογισμικό 

Ocean Compass (Chabeli Herrera, 2017)  

Καθώς οι επιβάτες κινούνται γύρω από το πλοίο, η εφαρμογή Ocean Compass προτείνει 
δραστηριότητες ανάλογα με τις προτιμήσεις τους. Η τεχνολογία αυτή εξαλείφει τις γραμμές 
αναμονής. Οι ταξιδιώτες που κάνουν online check-in μέσω των προφίλ τους στην εφαρμογή 
Ocean Compass, μπορούν να επιβιβαστούν στο πλοίο αμέσως καθώς τα μενταγιόν μπορούν 
να σταλούν ταχυδρομικά πριν από την αναχώρηση ή να παραλειφθούν στο λιμάνι.  

Η εταιρεία κρουαζιέρας εννέα γραμμών προγραμμάτισε να κάνει το ντεμπούτο της νέας 
αυτής τεχνολογίας για πρώτη φορά τον Νοέμβριο του 2017 στο πλοίο Regal Princess Cruises 
Princess από το Fort Lauderdale όμως αναβλήθηκε. Η Carnival Corporation επέλεξε μια 
σταδιακή εφαρμογή την άνοιξη του 2018, η οποία θα προσφέρει την τεχνολογία σε 
επιλεγμένες καμπίνες την φορά, προτού προσφερθεί πλήρως σε όλους τους επιβάτες του 
κρουαζιερόπλοιου. (Chabeli Herrera, 2017)     
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3. ΟΙ ΠΟΛΥΜΕΣΙΚΕΣ ΕΦΑΡΜΟΓΕΣ ΩΣ ΕΡΓΑΛΕΙΟ 
ΠΡΟΩΘΗΣΗΣ ΤΗΣ ΤΟΥΡΙΣΤΙΚΗΣ ΒΙΟΜΗΧΑΝΙΑΣ 

 

3.1 ΒΑΣΙΚΕΣ ΕΝΝΟΙΕΣ  

 

3.1.1 ΟΡΙΣΜΟΣ ΤΟΥΡΙΣΜΟΥ 

Σύμφωνα με τον Παγκόσμιο Οργανισμό Τουρισμού (World Tourism Organization), ο 
τουρισμός είναι οι δραστηριότητες των ατόμων που μετακινούνται και διαμένουν σε μέρη 
εκτός του καθημερινού τους περιβάλλοντος για λιγότερο από ένα έτος, για αναψυχή ή άλλους 
λόγους. Η λέξη τουρισμός προέρχεται από τη γαλλικά λέξη tour και σημαίνει μετακίνηση 
ατόμων ή ομάδων ατόμων από την περιοχή στην οποία διαμένουν σε μία άλλη, με σκοπό την  
σύναψη επαγγελματικών συμφωνιών, την εξερεύνηση νέων τόπων κλπ. (Υφαντίδου & 
Κώστα)  

 

3.1.2 ΤΙ ΕΙΝΑΙ ΤΑ ΠΟΛΥΜΕΣΑ  

Οι περισσότερες σύγχρονες εφαρμογές είναι πολυμεσικές και διαδραστικές. Ως πολυμέσα 
(multimedia) ή πολυμεσικές εφαρμογές, ονομάζονται όλες οι εφαρμογές που συνδυάζουν 
κείμενο, εικόνα, ήχο, βίντεο και animation (κινούμενη εικόνα ή προσομοίωση κίνησης) ή 
συνδυασμό τουλάχιστον δύο από τα παραπάνω στοιχεία. Βασικό στοιχείο των πολυμεσικών 
εφαρμογών είναι η διαδραστικότητα (interactivity). Η διαδραστικότητα δηλώνει την 
δυνατότητα αλληλεπίδρασης του χρήστη με την εφαρμογή και τον καθορισμό της εξέλιξής 
της. Αυτό επιτυγχάνεται μέσω των διαθέσιμων επιλογών που δίνει η εφαρμογή στον χρήστη, 
για τον καθορισμό της σειράς ή του τρόπου σειράς των πληροφοριών. Οι εφαρμογές που δεν 
επιτρέπουν την επέμβαση στην ροή των πληροφοριών ονομάζονται μη αλληλεπιδραστικές ή 
παθητικές. 

Η δυνατότητα αλληλεπίδρασης και οι δυνατές διαδρομές πλοήγησης στην εφαρμογή 
δημιουργούνται με τη χρήση συνδέσμων (links) ή υπερ-συνδέσμων (hyperlinks). Οι 
σύνδεσμοι είναι σημεία σε μια εφαρμογή, όπου ο χρήστης μπορεί να κάνει κλικ με το ποντίκι 
ή με την αφή σε μια οθόνη αφής και να μεταφερθεί σε κάποιο άλλο σημείο της εφαρμογής. 
Οι εφαρμογές που συνδέονται με τη χρήση συνδέσμων και περιέχουν μόνο πληροφορίες σε 
μορφή κειμένου ονομάζονται υπερ-κείμενα (hypertext). Οι εφαρμογές που περιέχουν και 
άλλα μέσα π.χ. εικόνες, όπου μπορεί να υπάρχουν και σύνδεσμοι πάνω στην εικόνα 
ονομάζονται υπερ-μέσα (hypermedia).  

Ο αγγλικός όρος που έχει αποδοθεί ως πολυμέσα είναι multimedia. Ο όρος αυτός είναι 
σύνθετος και αποτελείται από την λατινική λέξη «multus» που σημαίνει «πολυάριθμος», 
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«πολλαπλός» και της λατινικής λέξης «medium» που σημαίνει «μέσο». Πρόσφατα η λέξη 
«medium» άρχισε να χρησιμοποιείται και ως  «ενδιάμεσος», «μεσολαβητής». Επομένως, 
multimedia σημαίνει «πολλαπλά μέσα» ή «πολλαπλοί διαμεσολαβητές».  (Λαζαρίνης, 2015), 
(Παντανο - Ροκου, 2002, σ. 29).  

  

3.2 ΔΟΜΙΚΑ ΣΤΟΙΧΕΙΑ ΤΩΝ ΠΟΛΥΜΕΣΩΝ  
Τα κύρια δομικά στοιχεία των πολυμέσων είναι τα εξής:  

Το κείμενο 

Το κείμενο αποτελεί το απλούστερο και το πιο διαδεδομένο μέσο παρουσίασης των 
πληροφοριών σε οποιοδήποτε εφαρμογή πολυμέσων. Χρησιμοποιείται για να παρουσιάσει το 
περιεχόμενο της εφαρμογής ή χρησιμοποιείτε στα κουμπιά πλοήγησης. Με την κατάλληλη 
επιλογή γραμματοσειράς, μεγέθους και χρώματος ο χρήστης μπορεί να δώσει έμφαση σε 
κάποιο σημείο της εφαρμογής. Πρέπει να γίνει σωστή επιλογή ώστε να εμφανίζεται σωστά σε 
όλα τα μέσα προβολής. 

 

Η εικόνα  

Η εικόνα επίσης αποτελεί ένα από τα κυριότερα συστατικά των πολυμεσικών εφαρμογών. 
Είναι ένα συνηθισμένο μέσο για την παρουσίαση πληροφοριών σε οπτικοποιημένη μορφή. 
Μια εικόνα μπορεί να είναι φωτογραφία που έχει ληφθεί από ψηφιακή φωτογραφική μηχανή 
ή ένα σχέδιο που έχει δημιουργηθεί με υπολογιστή. Τα θέματα που αφορούν τις εικόνες είναι 
ποικίλα κα αφορούν τον τρόπο αναπαράστασης των εικόνων στον υπολογιστή , δηλαδή την 
επεξεργασία των εικόνων (προσθήκη εφέ, αλλαγή μεγέθους κλπ.). Για την επεξεργασία των 
εικόνων υπάρχουν πολλά λογισμικά τόσο ελεύθερα όσο και επί πληρωμή.  

 

Ο ήχος  

Ο ψηφιακός ήχος προστίθεται σε πολλές εφαρμογές πολυμέσων ως εναλλακτικός τρόπος 
παρουσίασης των πληροφοριών, καθώς μπορεί να εντυπωσιάσει τον χρήστη με διάφορα 
ηχητικά εφέ.  

 

Animation (σχεδιοκίνηση) 

Τα animation είναι κινήσεις σχεδίων που δημιουργούνται στον υπολογιστή με ειδικό 
λογισμικό. Τα ίδια λογισμικά χρησιμοποιούνται για τη δημιουργία τρισδιάστατων γραφικών 
(3D). Η απόδοση τρισδιάστατης όψης, η προσθήκη υφής, σκιών και κίνησης στα 
τρισδιάστατα γραφικά προσφέρουν ένα εντυπωσιακό αποτέλεσμα στην εφαρμογή. 

 

Το βίντεο 
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Στις εφαρμογές πολυμέσων το βίντεο έχει ουσιαστικό ρόλο αφού μπορεί να χρησιμοποιηθεί 
για την παρουσίαση πολλών εννοιών με εύληπτο τρόπο.  (Λαζαρίνης, 2015)  

3.3 ΕΦΑΡΜΟΓΕΣ ΠΟΛΥΜΕΣΩΝ ΣΤΟΝ ΤΟΥΡΤΙΣΜΟ 
Ο τομέας του τουρισμού έχει να κερδίσει πολλά από την χρήση των πολυμέσων. Η 
ανάπτυξη της πληροφορικής και των υπολογιστών προσφέρει νέες δυνατότητες στην 
ενημέρωση και στην εξυπηρέτηση των πελατών, καθώς επίσης και στην καλύτερη οργάνωση 
και λειτουργία των τουριστικών επιχειρήσεων και υπηρεσιών. Η ανάπτυξη των πολυμέσων 
και του Internet συντέλεσαν στην αυτοματοποίηση των υπηρεσιών και στην παροχή υψηλού 
επιπέδου ενημέρωσης στους πελάτες. Με τα πολυμέσα υπάρχει η δυνατότητα δημιουργίας 
βάσεων δεδομένων, οι οποίες θα περιέχουν όλα τα απαραίτητα στοιχεία, τα οποία θα 
μπορούν να δοθούν στους πελάτες σε ηλεκτρονική ή μη μορφή.  

Πλέον, στις βάσεις δεδομένων υπάρχει η δυνατότητα αποθήκευσης multimedia 
πληροφοριών (εικόνες, ήχος, βίντεο κτλ.) και με αυτό τον τρόπο η διαδικασία ανανέωσης των 
περιεχομένων γίνεται ευκολότερη, ενώ αυξάνεται και η ποιότητα των πληροφοριών.  

Τα μέσα που μπορούν να χρησιμοποιηθούν για την μετάδοση των πληροφοριών αυξάνονται 
και εκτός των κλασσικών εντύπων υπάρχουν πλέον τα CD-ROM, οι τοποθεσίες web στο 
Internet, τα ηλεκτρονικά κιόσκια πληροφοριών κλπ. Μερικά παραδείγματα πολυμέσων στον 
τουρισμό είναι: (Parallel Distributed Processing Laboratory , n.d), (Ρεφιαδου, 2007), 
(panoramikifotografia, 2013). 

· Ηλεκτρονικά περίπτερα (κιόσκια): πρόκειται για υπολογιστές οι οποίοι τρέχουν 
ένα πρόγραμμα το ποίο δίνει πληροφορίες στον χρήστη μέσο οθόνης αφής, οι 
οποίες μπορεί να συνοδεύονται και από ήχο. Πατώντας το πλήκτρο εμφανίζονται 
επί της οθόνης οι πληροφορίες. Τα κιόσκια χρησιμοποιούνται κυρίως στα μουσεία 
με σκοπό την περιγραφή των εκθεμάτων.  

· Πανοραμική φωτογραφία: για την προβολή των ταξιδιωτικών προορισμών τον 
πιο σημαντικό ρόλο τον έχει η εικόνα. Η επανάσταση στις πανοραμικές 
φωτογραφίες ήρθε με την δημιουργία των εικονικών περιηγήσεων (virtual tours). 
Οι εικονικές περιηγήσεις χρησιμοποιήθηκαν για την προβολή των αρχαιολογικών 
χώρων, των μουσείων καθώς επίσης και των ξενοδοχείων. Με την χρήση της 
πανοραμικής εικόνας ο χρήστης έχει την δυνατότητα να δει τον χώρο όπως θα τον 
έβλεπε και από κοντά. 

· Τουριστικοί οδηγοί σε μορφή CD-ROM: ένα παράδειγμα τουριστικού CD-ROM 
ελληνικής παραγωγής είναι το "The complete multimedia CD-ROM of Crete" με 
θέμα την Κρήτη. Πρόκειται για μια συλλογή κειμένων, φωτογραφιών, χαρτών και 
πληροφοριών τουριστικής φύσης σωστά δομημένων σε ένα φιλικό προς τον 
χρήστη περιβάλλον. Μπορεί να λειτουργήσει σε έξι διαφορετικές γλώσσες και 
περιέχει ιστορικά στοιχεία, στοιχεία γα τοποθεσίες, ξενοδοχεία, λιμάνια κλπ.    
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4. ΤΟ ΠΡΟΓΡΑΜΜΑ MATCHWARE MEDIATOR 9  
 

4.1 ΓΕΝΙΚΑ ΓΙΑ ΤΟ MATCHWARE MEDIATOR 9   
Το Matchware Mediator 9 είναι ένα πρόγραμμα δημιουργίας διαδραστικών,  πολυμεσικών 
εφαρμογών και ιστοσελίδων. Είναι  ένα εύχρηστο και ισχυρό εργαλείο όπου μπορεί να 
χρησιμοποιηθεί από όλους δίχως να απαιτεί ειδικές γνώσεις προγραμματισμού. 
Χρησιμοποιείται για την δημιουργία διαδραστικών παρουσιάσεων και εφαρμογών σε μορφή 
CD-ROM, Flash, HTML, εφαρμογές που προορίζονται για οθόνες αφής (περίπτερα), για 
παρουσίαση προϊόντων σε εμπορικές εκθέσεις, καθώς επίσης και για e-learning. (Matchware , 
2017)     

Το Matchware Mediator 9 έχει πολλές δυνατότητες και είναι ταυτόχρονα πολύ εύχρηστο και 
φιλικό προς τον χρήστη. Είναι ένα πρόγραμμα με το οποίο μπορεί κάποιος να δημιουργήσει 
από μια απλή διαδραστική εφαρμογή έως μια πιο σύνθετη ιστοσελίδα. Συνδυάζει κείμενο, 
εικόνες, ήχο και βίντεο. Το ευκολονόητο περιβάλλον διεπαφής, και η τεχνολογία 
επεξεργασίας drag-and-drop επιτρέπει στον χρήστη να εισάγει αντικείμενα, κουμπιά, 
σχήματα κλπ. Εύκολα και σε ελάχιστο χρόνο. Το γεγονός ότι μπορεί να χρησιμοποιηθεί από 
οποιονδήποτε δίχως να απαιτεί ειδικές γνώσεις κάνει την δημιουργία μια απλή, γρήγορη και 
διασκεδαστική διαδικασία είναι κατάλληλο για χρήση από μαθητές και εκπαιδευτικούς στα 
πλαίσια εκπαιδευτικών εργαστηρίων, όπου οι μαθητές μπορούν να δημιουργήσουν 
αποτελεσματικά διαδραστικές ιστοσελίδες και εφαρμογές, παρέχοντάς τους την ισχύ που 
απαιτείται για επαγγελματικές παρουσιάσεις. Οι δυνατότητες του Matchware Mediator 9 
περιορίζονται μόνο από την φαντασία και την δημιουργικότητα του χρήστη. (Matchware , 
2017), (Matchware , 2007)      

 Η εταιρεία Matchware ιδρύθηκε το 1992 και είναι ο ηγέτης στα εύχρηστα εργαλεία 
δημιουργίας πολυμεσικών εφαρμογών για επιχειρήσεις και για μη επαγγελματίες. Τα 
κεντρικά γραφεία της εταιρείας βρίσκονται στην Δανία και έχει θυγατρικές εταιρείες σε 
Ηνωμένο Βασίλειο, Ηνωμένες Πολιτείες Αμερικής και Γερμανία. Το πρόγραμμα Matchware 
Mediator 9 κυκλοφορεί και διαμένετε μέσα από την επίσημη ιστοσελίδα της Matchware στο 
www.matchware.com.  (Matchware , 2018)    

   

4.2 ΧΑΡΑΚΤΗΡΙΣΤΙΚΑ ΤΟΥ MATCHWARE MEDIATOR 9   
Το Mediator 9 αποτελεί ένα από τα πιο ισχυρά και φιλικά προς τον χρήστη προγράμματα 
μέχρι σήμερα. Αποτελείται από την συγχώνευση του Mediator Pro και του Mediator Exp, 
προκειμένου τα χαρακτηριστικά και των δύο εκδόσεων να είναι διαθέσιμα σε όλους. Η πιο 
πρόσφατη αναβάθμιση του Mediator 9 περιλαμβάνει ένα ολοκαίνουργιο περιβάλλον 
διεπαφής σαν το Office 2007, αντικείμενο κειμένου, βελτιωμένη επεξεργασία HTML, 

http://www.matchware.com
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συμβατότητα SCORM κλπ. Μερικά από τα νέα, εντυπωσιακά χαρακτηριστικά του Mediator 
9 περιλαμβάνουν: 

· Περιβάλλον διεπαφής βασισμένο στο Office 2007 
· Εφέ με στιγμιαία προεπισκόπηση  
· Νέο αντικείμενο κειμένου 
· Ενεργοποίηση Unicode  
· Συμβατότητα SCORM 
· Βελτίωση Flash 
· Όλα τα χαρακτηριστικά από την συγχώνευση των εκδόσεων Pro και Exp. 

 

Περιβάλλον διεπαφής βασισμένο στο Office 2007: Το ολοκαίνουργιο περιβάλλον διεπαφής 
του Mediator 9είναι βασισμένο στο περιβάλλον διεπαφής του Microsoft Office 2007. Αυτό το 
καινοτόμο περιβάλλον διεπαφής επιτρέπει στον χρήστη να δημιουργήσει εντυπωσιακές 
παρουσιάσεις πιο γρήγορα και πιο εύκολα από ποτέ, με επιλογές όπως: 

Ø Εντολές οργανωμένες σε καρτέλες, με προσανατολισμό εργασιών και σύνολα 
σχετικών επιλογών, έτσι ώστε ο χρήστης να βρίσκει ακριβώς ότι χρειάζεται εύκολα 
και γρήγορα. 

Ø Συλλογές προκαθορισμένων στυλ, όπου επιτρέπουν στον χρήστη να δημιουργήσει 
την εμφάνιση που θέλει κάνοντας απλά ένα κλικ. 
  

 
Εικόνα 5: Περιβάλλον διεπαφής βασισμένο στο Office 2007 (Matchware, 2007) 

 

Εφέ με στιγμιαία προεπισκόπηση: Το Mediator 9 προσφέρει νέα στυλ, νέα εφέ και 
βελτιωμένες επιλογές μορφοποίησης. Η προεπισκόπηση σας επιτρέπει να εξετάσετε τις 
επιδράσεις των διαφόρων επιλογών μορφοποίησης στα αντικείμενα πριν από την εφαρμογή 
τους και να τα εφαρμόσετε με ένα κλικ.  
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Νέο αντικείμενο κειμένου: Το αντικείμενο κειμένου του Mediator έχει επανασχεδιαστεί 
πλήρως για να προσφέρει όλες τις δυνατότητες που προσφέρονται από τους τυπικούς 
επεξεργαστές κειμένου, όπως ένα ευρύ φάσμα επιλογών μορφοποίησης κειμένου όπως η 
δυνατότητα δημιουργίας πίνακα, η εισαγωγή εικόνας, ορθογραφικός έλεγχος κλπ.  

Ενεργοποίηση Unicode: Στο Mediator 9 είναι τώρα ενεργοποιημένο το Unicode, 
επιτρέποντας στον χρήστη να εισάγει κείμενο σε αντικείμενα σε πολλές διαφορετικές 
γλώσσες συμπεριλαμβανομένου και των μη δυτικών γλωσσών.  

 

Συμβατότητα SCORM: Το Mediator 9 καθιστά δυνατή τη δημιουργία σειρών μαθημάτων 
συμβατών με SCORM για εξαγωγή σε Flash ή HTML και να τα ανεβάσει ο χρήστης σε ένα 
Σύστημα Διαχείρισης Μάθησης (Learning Management System-LMS) ή σε ένα Εικονικό 
Περιβάλλον Μάθησης (Virtual Learning Environment- VLE). Η ανταλλαγή δεδομένων 
μεταξύ του μαθήματος και του Learning Management System (LMS) πραγματοποιείται μέσω 
δύο ειδικών ενεργειών SCORM, του Set SCORM Variable και του Get SCORM Variable. 

 

 
Εικόνα 6: SCORM (Matchware, 2007)  

 

 

Βελτίωση Flash: Τα αρχεία βίντεο (.flv) και τα αντικείμενα List Box μπορούν πλέον να 
χρησιμοποιηθούν στην εξαγωγή Flash. Ο χρήστης μπορεί να κάνει εξαγωγή ενός εγγράφου 
Flash, ως ενιαίου αρχείου Flash για ευκολότερη διαχείριση και ταχύτερη αλλαγή σελίδων.  
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Εικόνα 7: Flash Export (Matchware, 2007)  

 

Όλα τα χαρακτηριστικά από την συγχώνευση των εκδόσεων Pro και Exp: Όλες οι 
λειτουργίες που προορίζονταν προηγουμένως για το Mediator Exp έχουν πλέον ενσωματωθεί 
στο Mediator 9, διευρύνοντας τις δυνατότητες του. Οι λειτουργίες του Mediator Exp που 
είναι πλέον μέρος του Mediator 9 περιλαμβάνουν: 

· Script Action: Ο χρήστης μπορεί να προσθέσει στις σελίδες δέσμες ενεργειών χρόνου 
εκτέλεσης (VB ή Java) ή μακροεντολών. 
 

·  HTTP request: Ο χρήστης μπορεί να χρησιμοποιήσει το HTTP request στην 
εξαγωγή εγγράφων Flash ή HTML, ώστε να υπάρχει επικοινωνία με τους διακομιστές 
ιστούς.  

 
Εικόνα 8: Http Request (Matchware, 2007)  

 
· Animation Track action: Ο χρήστης μπορεί να αποκτήσει τον απόλυτο έλεγχο πάνω 

στη θέση, το μέγεθος, τη περιστροφή, την αδιαφάνεια και την ταχύτητα των 
αντικειμένων.  
 

· Active X objects: Ο χρήστης μπορεί να χρησιμοποιήσει κάποιο υπάρχον ή να 
δημιουργήσει το δικό του. 



 
25 

 

· Smooth 3D Effects on Page Turn: Το Mediator 9 περιλαμβάνει εντυπωσιακά εφέ 3D 
για χρήση στη σελίδα μετάβασης. 
 

· Ήχος και ενέργειες: Ένα ολοκαίνουργιο χρονοδιάγραμμα ήχου βελτιώνει το 
συγχρονισμό του ήχου και των ενεργειών. Οι ήχοι αντιπροσωπεύονται πλέον από 
ένα "κύμα", καθιστώντας εύκολο τον συγχρονισμό των ενεργειών με τον ήχο. 
 

· Αντικείμενο HTML Code: Ένα νέο αντικείμενο κώδικα HTML επιτρέπει στους 
χρήστες να ενσωματώσουν κώδικα HTML στις σελίδες του Mediator 9. Επίσης, το 
αντικείμενο HTML περιέχει προκαθορισμένα δείγματα κώδικα HTML που μπορούν 
να εφαρμοστούν όπως προβλέπεται ή προσαρμόζεται για μεμονωμένα έγγραφα,   
 

· Μετακίνηση σελίδων HTML: Σε παλαιότερες εκδόσεις του Mediator, οι σελίδες 
HTML μπορούσαν να σχεδιαστούν μόνο σε μια προκαθορισμένη ανάλυσης οθόνης. 
Το Mediator 9 επιτρέπει στον χρήστη να επιλέξει διαφορετικά ύψη σελίδων για το 
έγγραφο HTML και να προσαρμόσει τις διαστάσεις στο περιεχόμενο μεμονωμένων 
σελίδων, όπως θα έκανε με έναν επεξεργαστή HTML. 
 

· Site Map: Το Mediator 9 επιτρέπει στον χρήστη να δημιουργήσει αυτόματα έναν 
χάρτη ιστοτόπου XML, αυξάνοντας έτσι τη προβολή των ιστοσελίδων για τις 
μηχανές αναζήτησης.  (www.matchware.com), (Matchware , 2007) 

 

4.3 ΕΓΚΑΤΑΣΤΑΣΗ ΤΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ MEDIATOR 9   
Το Mediator 9 μπορεί να το προμηθευτεί κάποιος μέσω της επίσημης ιστοσελίδας της 
εταιρείας στο www.matchware.com. Εκεί μπορεί να βρει όλα τα διαθέσιμα προγράμματα της 
εταιρείας συμπεριλαμβανομένου και του Mediator 9, όπου και διατίθενται σε τουλάχιστον 
τρείς διαφορετικές γλώσσες. Υπάρχει δυνατότητα δωρεάν λήψης του Mediator 9 στην 
έκδοση και στην γλώσσα που θέλει ο χρήστης, καθώς επίσης και η δυνατότητα αγοράς του 
ολοκληρωμένου πακέτου όπου περιλαμβάνει το πρόγραμμα με το CD. Ακόμα, στην επίσημη 
ιστοσελίδα της εταιρείας ο χρήστης μπορεί να βρει και το εγχειρίδιο του προγράμματος, όπου 
αναλύει τις δυνατότητες του προγράμματος. (Matchware, 2007)  

Τα βήματα εγκατάστασης του Mediator 9 που πρέπει να ακολουθήσει ο χρήστης, μέσω του 
CD που περιλαμβάνει το ολοκληρωμένο πακέτο είναι τα ακόλουθα: 

· Stand-Alone Installation (Αυτόνομη εγκατάσταση) 
Ø Εισαγωγή του CD-ROM στην μονάδα υποδοχής δίσκου 
Ø Εκτέλεση των οδηγιών που εμφανίζονται στην οθόνη κατά την διάρκεια 

εγκατάστασης του προγράμματος Mediator 9 

 

Σε περίπτωση που η εγκατάσταση του προγράμματος δεν ξεκινήσει αυτόματα τότε ο 
χρήστης πρέπει να επιλέξει Start-Run και να πληκτρολογήσει το ακόλουθο: 

http://www.matchware.com)
http://www.matchware.com
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Ø X: \start.exe 
(Όπου το γράμμα X αντιπροσωπεύει την μονάδα δίσκου/CD-ROM). 
 

· Administrative installation (μόνο διαχειριστές συστήματος)  
Το πρόγραμμα εγκατάστασης των Windows, μπορεί να πραγματοποιήσει μια 
διαχειριστική εγκατάσταση (administrative installation) μιας εφαρμογής ή ενός 
προϊόντος σε ένα δίκτυο για χρήση από μια ομάδα εργασίας.  
Η συγκεκριμένη εγκατάσταση , εγκαθιστά μια εικόνα προέλευσης της εφαρμογής 
στο δίκτυο, που είναι παρόμοια με μια εικόνα πηγής σε ένα CD-ROM.  Το πακέτο 
της διαχειριστικής εγκατάστασης (administrative installation) μπορεί να προωθηθεί 
από τους διαχειριστές συστημάτων στην δικαιοδοσία του υπολογιστή-πελάτης δια 
μέσου πολιτικών ομάδων.  Αυτό είναι δυνατόν μόνο από Windows 2000 Server και 
μετά.  
 

· Δημιουργία μιας διαχειριστικής εγκατάστασης (administrative installation) 
Ο διαχειριστής μπορεί να δημιουργήσει μια διαχειριστική εγκατάσταση 
(administrative installation) από την γραμμή εντολών, χρησιμοποιώντας την επιλογή 
της γραμμής εντολών. Επιλέγει Start-Pun και πληκτρολογεί το ακόλουθο: 
Ø misexec.exe / a X: \ install \ setup.msi 

Όπου το γράμμα X αντιπροσωπεύει την μονάδα δίσκου.(Έλεγχος τοποθεσίας του 
setup.msi στο CD-ROM). 

Στο παράθυρο διαλόγου που θα εμφανιστεί ο διαχειριστής πρέπει να καθορίσει τα 
ακόλουθα: 

Ø Που θέλει να αποσυμπιεστεί το αρχείο .msi 
Ø Το όνομα χρήστη και το όνομα εταιρείας να χρησιμοποιούνται ως προεπιλογή 
Ø Τον σειριακό αριθμό 

 (Προαιρετικά) Μπορεί να επιλέξει το ‘Force activation when Mediator is Run’ εάν θέλει το 
Mediator να ενεργοποιηθεί αυτόματα την πρώτη φορά που τρέχει το πρόγραμμα. 

(Προαιρετικά) Μπορεί να επιλέξει το  ‘Automatically activate during installation’ εάν θέλει 
το Mediator να ενεργοποιηθεί κατά την διάρκεια της εγκατάστασης.  

 Αυτές οι δύο επιλογές ενεργοποίησης είναι ‘σιωπηλές’, δηλαδή δεν παρουσιάζουν 
κανένα μήνυμα. 

 Οι πιο πάνω επιλογές αποθηκεύονται σε έναν φάκελο που ονομάζεται ‘admin.ini’ 
στον φάκελο προορισμού. Ο διαχειριστής μπορεί να επεξεργαστεί αυτό το αρχείο  
χρησιμοποιώντας έναν επεξεργαστή κειμένου όπως είναι το Notepad, εάν θέλει να 
αλλάξει τις επιλογές δίχως να κάνει νέα διαχειριστική εγκατάσταση (administrative 
installation). 

 

· Εφαρμογή ενός πακέτου ενημερωμένης έκδοσης κώδικα (patch package) σε μια 
διαχειριστική εγκατάσταση (administrative installation) 
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Ο διαχειριστής πρέπει να επιλέξει Start-Run και στη συνέχεις να πληκτρολογήσει το 
ακόλουθο: 
Ø msiexec.exe / p <path to .msp file> a <path to administrative .msi file> 

 
Τα μέλη της ομάδας εργασίας με τη χρήση του Mediator θα πρέπει στη 
συνέχεις να επανεγκαταστήσουν την εφαρμογή από την νέα διαχειριστική 
πηγή αντιγράφου, έτσι ώστε να λάβει την ενημερωμένη έκδοση.  
 
Για να γίνει επανεγκατάσταση πλήρως της εφαρμογής και προσωρινή 
αποθήκευση του ενημερωμένου αρχείου .msi στον υπολογιστή, ο 
διαχειριστής μπορεί να καταχωρήσει μια από τις ακόλουθες εντολές: 

Ø msiexec.exe /fvomus //server/<administrative .msi file> 
Ø msiexec.exe / I//server//<administrative .msi file>  REISTALL=ALL 

REINSTALLMODE=vomus 
 

· Αντιμετώπιση προβλημάτων 
 
Ø Αλλαγή της θέσης του αρχείου ενεργοποίησης 

Από προεπιλογή, τα δεδομένα ενεργοποίησης είναι αποθηκευμένα στο: 
C:\Documents and Settings\All Users\Application Data\mwas\Mediator 9.0 
Exp.mwas  

Σε μερικές σπάνιες περιπτώσεις ο πελάτης-υπολογιστής ενδέχεται να είναι ρυθμισμένοι με 
περιορισμένη πρόσβαση στον παραπάνω φάκελο, και αυτό θα προκαλέσει το αρχείο 
ενεργοποίησης να μη σωθεί. Εάν έχει γίνει ρύθμιση του συστήματος διακομιστή-υπολογιστή 
με αυτόν τον τρόπο, ο διαχειριστής μπορεί να μεταφέρετε το αρχείο ενεργοποίησης σε μια 
άλλη τοποθεσία προσθέτοντας μια καταχώρηση στο admin.ini αρχείο ως εξής:  

(Activation) 

mwas =c:\\different folder with write access\Mediator 9.0 Exp.mwas 

 

Ø Αποθήκευση πολλών αρχείων ενεργοποίησης στον server 
Ο διαχειριστής μπορεί να αποθηκεύσει πολλά αρχεία ενεργοποίησης στον 
ίδιο φάκελο του server (διακομιστή), προσθέτοντας μια καταχώρηση στο 
αρχείο admin.ini ως εξής: 
 
(Activation) 
mwas=\\server\activations\Mediator 9.0 Exp_%COMPUTERNAME%.mwas 
Όπου: 
Server: το όνομα του server (διακομιστή) 
Activations: το όνομα που χρησιμοποιεί στον server 
%COMPUTERNAME% θα αντικατασταθεί με το όνομα του υπολογιστή-
πελάτη.  
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· Πρόβλημα με την εφαρμογή ενημερωμένης έκδοσης κώδικα 
 
Ø Ερώτηση: Δεν γίνεται τίποτα όταν κάνω διπλό κλικ στο αρχείο λογισμικού 

ενημέρωσης (ex.patch.msp). 
Ø Απάντηση:  Το αρχείο επέκτασης .msp μπορεί να διατεθεί σε μια άλλη 

εφαρμογή από εγκατάσταση με Windows. 

Σε αυτή την περίπτωση ο διαχειριστής μπορεί να εφαρμόσει το λογισμικό 
ενημέρωσης επιλέγοντας Start-Run και πληκτρολογώντας την ακόλουθη εντολή: 

Ø msiexec.exe /p c : \temp\patch.mcp 
 
(Προϋπόθεση ότι έχει γίνει αντιγραφή του αρχείου .msp στο c:\temp)  

 

4.4 QUICK START (ΓΡΗΓΟΡΗ ΕΚΚΙΝΗΣΗ)  
Η "γρήγορη εκκίνηση" δείχνει στον χρήστη τις βασικές αρχές του Mediator 9 , και πώς να 
χρησιμοποιήσει τις πιο σημαντικές λειτουργίες του σε λίγα μόνο βήματα και με την βοήθεια 
παραδειγμάτων. Υπάρχουν μόνο τρία βασικά βήματα τα οποία πρέπει να μάθει κάποιος ώστε 
να ξεκινήσει να χρησιμοποιεί το Matchware Mediator 9 τα οποία είναι: (Matchware, 2007)  

1. Δημιουργία αντικειμένων: (προσθήκη αντικειμένων στις σελίδες, όπως εικόνες, 
βίντεο, κείμενο κλπ). 
 

2. Δημιουργία σελίδων: (προσθήκη και επεξεργασία επιπλέον σελίδων). 
 

3. Δημιουργία διαδραστικότητας: (προσθήκη διαδραστικότητας). 

 
Εικόνα 9: Εργαλεία γρήγορης εκκίνησης (Matchware, 2007)  

· Δημιουργία εγγράφου 
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Το παράθυρο υποδοχής είναι η πρώτη οθόνη που εμφανίζεται όταν ξεκινάει το Mediator 9. 
Τα βήματα που ακολουθεί ο χρήστης είναι τα ακόλουθα: 

Ø "Create a new document" δια την δημιουργία κενού εγγράφου. 
Ø Κλικ στο κουμπί "ΟΚ" για αποδοχή του προεπιλεγμένου τύπου εγγράφου, 

δηλαδή "Standard" . 
Ø Κλικ στο κουμπί "ΟΚ" για αποδοχή της προεπιλεγμένης λειτουργίας 

παραθύρου, δηλαδή "Full screen with frame".  

 

4.4.1 ΠΡΩΤΟ ΒΗΜΑ – ΔΗΜΙΟΥΡΓΙΑ ΑΝΤΙΚΕΙΜΕΝΩΝ  

Η λέξη "αντικείμενο" αναφέρεται σε όλα τα στοιχεία όπου μπορεί ο χρήστης να τοποθετήσει 
στις σελίδες του, όπως το φόντο, το κείμενο, τις εικόνες, το βίντεο και ούτω καθεξής.  

Για την τοποθέτηση των αντικειμένων στην σελίδα ο χρήστης χρησιμοποιεί την καρτέλα 
Insert που βρίσκεται στο κύριο μενού. 

Ø  Κλικ στην καρτέλα Insert 

 

 
Εικόνα 10: Καρτέλα Insert 

 

Η προσθήκη αντικειμένων στη σελίδα, γίνετε με αριστερό κλικ πάνω στο αντίστοιχο 
εικονίδιο. Ο δείκτης του ποντικιού αλλάζει ανάλογα με την επιλογή του αντικειμένου. Η 
διαδικασία είναι η ίδια για όλα τα αντικείμενα εκτός από το Κείμενο, το Πολύγωνο και το 
Animation Path. 

Τα βήματα εισαγωγής ενός ορθογώνιου σχήματος είναι τα ακόλουθα: 

Ø Κλικ στο εικονίδιο Rectangle   που βρίσκεται στο Illustrations γκρουπ. 
Ø Κρατώντας πατημένο το αριστερό κουμπί από το ποντίκι, ο χρήστης σχηματίζει στην 

σελίδα ένα πλαίσιο για το ορθογώνιο. 
Ø Αφού σχεδιάσει το σχήμα, αφήνει το κουμπί ώστε να ολοκληρωθεί το σχήμα. 

Με την ολοκλήρωση του σχήματος εμφανίζεται η καρτέλα Format, όπου επιτρέπει στον 
χρήστη να τροποποιήσει τις ιδιότητες του ορθογωνίου. 
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Εικόνα 11: Καρτέλα Format- Ιδιότητες ορθογωνίου 

 

Ø Ο χρήστης μπορεί να περιηγηθεί στη συλλογή με τα διαφορετικά στυλ ελέγχοντας την 
επίδραση κάθε στυλ στο ορθογώνιο, καθώς μετακινεί τον δείκτη του ποντικιού από 
πάνω, και να πατήσει αριστερό κλικ για την εφαρμογή κάποιου.  

 

Τα βήματα εισαγωγής ενός κουμπιού στη σελίδα είναι τα ακόλουθα: 

Ø Κλικ στην καρτέλα Insert  

Ø Κλικ στο βέλος που βρίσκεται στο κάτω μέρος του εικονιδίου Button  που 
βρίσκεται στο Controls γκρουπ. 

Ø Ο χρήστης επιλέγει το κουμπί που του αρέσει περισσότερο, μέσα από τις κατηγορίες 
προκαθορισμένων κουμπιών. 

Ø Κρατώντας πατημένο το αριστερό κουμπί, ο χρήστης σχηματίζει στη σελίδα ένα 
πλαίσιο για το κουμπί.  

Ø Το προεπιλεγμένο κείμενο στο κουμπί είναι "Button", αλλά το όνομα μπορεί να 

αλλάξει κάνοντας διπλό κλικ πάνω στο κουμπί    . 

 

4.4.2 ΔΕΥΤΕΡΟ ΒΗΜΑ – ΧΡΗΣΙΜΟΠΟΙΩΝΤΑΣ ΤΗΝ PAGE LIST (ΛΙΣΤΑ ΣΕΛΙΔΩΝ) 

  Όλες οι σελίδες που περιέχονται στη παρουσίαση παρατίθενται στη Page List. Από 
προεπιλογή, όταν ο χρήστης ανοίγει το Mediator 9 υπάρχει ήδη μια σελίδα που ονομάζεται 
"Page 1".  

 
Εικόνα 12: Page 1 

 

 

Το επόμενο βήμα είναι η δημιουργία μιας ακόμη σελίδας στην παρουσίαση. Για τη 
δημιουργία νέας σελίδας ο χρήστης: 

Ø Πηγαίνει στην καρτέλα Home 

Ø Επιλέγει το επάνω μέρος του εικονιδίου New   που βρίσκεται στο Pages γκρουπ. 
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Όταν δημιουργηθεί η νέα σελίδα, το Mediator θα την προσθέσει αυτόματα κάτω από την 
ήδη υπάρχουσα σελίδα. 

 
Εικόνα 13: Page 2  

 

 

Για να γίνει η μετάβαση από την Page1 στην Page2, ο χρήστης απλά επιλέγει την σελίδα 
κάνοντας αριστερό κλικ πάνω στην σελίδα που βρίσκεται στην Page List. 

  

4.4.3 ΤΡΙΤΟ ΒΗΜΑ – ΔΗΜΙΟΥΡΓΙΑ ΔΙΑΔΡΑΣΤΙΚΟΤΗΤΑΣ  

  Εφόσον ο χρήστης έχει δημιουργήσει τις σελίδες, το επόμενο και τελευταίο βήμα 
είναι να δημιουργήσει διαδραστικότητα μεταξύ των σελίδων. Αυτό θα το επιτύχει με την 
χρήση του παραθύρου Events. Το παράθυρο Events είναι αυτό που καθιστά το Mediator τόσο 
ισχυρό. Επιτρέπει στον χρήστη με την "drag and drop" λειτουργία, να δημιουργεί 
εντυπωσιακές παρουσιάσεις δίχως καμία γνώση προγραμματισμού.  

Το πρώτο που πρέπει να κάνει ο χρήστης, είναι να συνδέσει  τη Page1 με την Page2. Αυτό 
μπορεί να το επιτύχει με τον ακόλουθο τρόπο: 

· Επιλογή της Page1 από την Page List, και στη συνέχεια επιλογή του κουμπιού που 
είχε δημιουργήσει νωρίτερα στην Page1. 
 

· Επιλογή του κουμπιού στη Page1 κάνοντας αριστερό κλικ πάνω στο κουμπί. 
 

Πρέπει να προγραμματιστεί το κουμπί, έτσι ώστε όταν ο χρήστης κάνει κλικ πάνω στο 
κουμπί να οδηγεί στη Page2. Για να εφαρμοστεί αυτή η λειτουργία πρέπει να χρησιμοποιηθεί 
τι παράθυρο Events. 

·  Δεξί κλικ πάνω στο κουμπί και επιλογή της ενέργειας Events από το μενού που θα 
εμφανιστεί. 

Εμφανίζεται το παράθυρο Events όπου και θα χρησιμοποιηθεί για τον προγραμματισμό του 
κουμπιού. 
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Εικόνα 14: Παράθυρο διαδραστικότητας- Events (Matchware, 2007) 

 

Στην αριστερή πλευρά του παραθύρου Events, εμφανίζεται η λίστα όλων των πιθανών 
συμβάντων. Ένα event είναι κάτι που μπορεί να συμβεί σε ένα αντικείμενο. Στην κορυφή του 
παραθύρου Events εμφανίζεται η λίστα με όλες τις πιθανές ενέργειες. Μια ενέργεια είναι κάτι 
που ενεργοποιείται από ένα event όπως για παράδειγμα η αναπαραγωγή ενός ήχου κλπ. 

Η δημιουργία διαδραστικότητας στο παράθυρο Events συνίσταται πάντοτε στο συνδυασμό 
τουλάχιστον ενός event με μια ή περισσότερες ενέργειες.  

Για να υπάρχει δυνατότητα το κουμπί να πηγαίνει στην Page2 πρέπει να συνδυαστούν το 
event Mouse Click με την ενέργεια Go to Page. 

· Αφού επιλεχθεί το event Mouse Click  στη συνέχεια  σύρετε στη μεγάλη κενή 
επιφάνεια που ονομάζεται ενεργό πεδίο. 

· Στη συνέχεια, επιλέγεται η ενέργεια Go to Page   και σύρετε στη μεγάλη κενή 
επιφάνεια δεξιά του event Mouse Click. 

 

Μόλις ολοκληρωθεί η ενέργεια εμφανίζεται το παράθυρο Go to Page. 
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Εικόνα 15: Παράθυρο Go to Page (Matchware, 2007) 

 

Αυτό το παράθυρο επιτρέπει στον χρήστη να επιλέξει τη σελίδα στην οποία θέλει να 
μεταβαίνει όταν κάνει κλικ στο κουμπί. Κάθε φορά που ο χρήστης σύρει μια ενέργεια Go to 
Page στο ενεργό πεδίο, το παράθυρο διαλόγου Go to Page ανοίγει αυτόματα μια λίστα 
σελίδων. 

· Επιλογή της Page2 από την λίστα σελίδων που εμφανίζονται και κλικ στο κουπί ΟΚ. 

 

Το εικονίδιο Mouse Click είναι αμετάβλητο, αλλά το εικονίδιο Go to Page τώρα φέρει την 
ένδειξη "Page2", υποδεικνύοντας ότι το κουμπί έχει προγραμματιστεί να μεταβαίνει στην 
Page2 όταν ο χρήστης κάνει αριστερό κλικ στο κουμπί. 

 

 
Εικόνα 16: Παράθυρο Event (Matchware, 2007) 
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5. Η ΑΝΑΠΤΥΞΗ ΤΗΣ ΕΦΑΡΜΟΓΗΣ 
 

5.1 ΔΗΜΙΟΥΡΓΙΑ ΕΦΕΡΜΟΓΗΣ ΜΕ ΤΟ MEDIATOR 9     
Το υποκεφάλαιο "δημιουργία εφαρμογής" περιγράφει όλες τις κύριες λειτουργίες που 
μπορεί ο χρήστης να εκτελέσει στο Mediator, όπως για παράδειγμα την ρύθμιση και τον 
σχεδιασμό του εγγράφου, καθώς επίσης και όλες τις διαθέσιμες λειτουργίες κάθε 
αντικειμένου ξεχωριστά.  

5.1.1 ΠΡΟΓΡΑΜΜΑΤΙΣΜΟΣ ΕΓΓΡΑΦΟΥ  

Το πρώτο βήμα για τη δημιουργία ενός εγγράφου πολυμέσων στο Mediator, είναι ο 
προγραμματισμός του σχεδίου του και η μελέτη των βασικών χαρακτηριστικών του: 

· Τον τύπο των μέσων που χρειάζονται (εικόνες, βίντεο κλπ.). 
· Το επίπεδο αλληλεπίδρασης χρήστη που απαιτείται (κουμπιά πλοήγησης, εισαγωγή 

κειμένου από τον χρήστη, ιστοσελίδα κλπ.). 
· Οι πλατφόρμες από τις οποίες θα υποστηρίζεται το έγγραφο (π.χ. Windows XP, 

κλπ.). 
· Η μορφή εξαγωγής που απαιτείται (CD-ROM, Flash, HTML κλπ.). 
·  Οι προδιαγραφές του υπολογιστή που προορίζεται (ταχύτητα του υπολογιστή, 

ανάλυση οθόνης και χρώματος, κλπ.). 

 

Το Mediator προσφέρει τρείς διαφορετικούς τύπους εγγράφων, που αντιστοιχούν στις 
μορφές εξαγωγής του: 

 
Εικόνα 17: Τύποι εγγράφων 

 

· Το έγγραφο τύπου Standard επιτρέπει στον χρήστη να δημιουργήσει ένα έγγραφο 
κατάλληλο για διανομή σε CD-ROM, ή άλλο αφαιρούμενο μέσο αποθήκευσης 
(DVD-ROM, USB stick κλπ.). Ο συγκεκριμένος τύπος εγγράφου δίνει πρόσβαση 
στον χρήστη στις περισσότερες δυνατότητες.  
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Για την ομαλή λειτουργία του εγγράφουν, οποιουδήποτε τύπου, καλό είναι πριν τελική 
εξαγωγή να έχουν προηγηθεί πολλές δοκιμές κάθε τμήματος ξεχωριστά που ολοκληρώνεται, 
ώστε τυχόν λάθη να εντοπίζονται εγκαίρως. (Matchware, 2007) 

 

5.1.2 ΣΧΕΔΙΑΣΜΟΣ ΕΓΓΡΑΦΟΥ   

  Όταν ξεκινήσει για πρώτη φορά το Mediator 9, το πρώτο που εμφανίζεται στην οθόνη 
είναι το παράθυρο καλωσορίσματος: 

 

 
Εικόνα 18: Παράθυρο έναρξης  

  

Εδώ ο χρήστης μπορεί να επιλέξει ανάμεσα στα ακόλουθα: 

· Δημιουργία νέου εγγράφου 
· Άνοιγμα ενός εγγράφου το οποίο υπάρχει ήδη 
· Άνοιγμα των πιο πρόσφατων εγγράφων που έχει δημιουργήσει ο χρήστης 
· Η επιλογή Template Wizard (προσφέρει την δυνατότητα δημιουργίας νέων εγγράφων 

σε μικρό χρονικό πλαίσιο, κάνοντας χρήση των έτοιμων βοηθητικών προτύπων). 

 

Ακόμα ο χρήστης μπορεί να δημιουργήσει καινούριο έγγραφο και με τους ακόλουθους 
τρόπους: 

· Πατώντας τα κουμπιά Ctrl+N. 
· Επιλέγοντας το κουμπί του Mediator και στη συνέχεια New. 

· Επιλέγοντας το εικονίδιο New  που βρίσκεται δεξιά από το κουμπί του Mediator. 
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Το επόμενο βήμα είναι ο καθορισμός του τύπου εγγράφου που θέλει να δημιουργήσει ο 
χρήστης. Μπορεί να επιλέξει: 

· Standard: για την δημιουργία πολυμεσικής παρουσίασης η οποία θα αποθηκεύεται σε 
CD-ROM η άλλο αφαιρούμενο μέσο αποθήκευσης. 

· HTML: για τη δημιουργία ιστότοπου HTML ή παρουσίασης HTML. 
· Flash: για τη δημιουργία Flash banner ή ιστότοπου Flash. 

 

Δημιουργία εγγράφου τύπου Standard 

Όταν ο χρήστης επιλέξει να δημιουργήσει ένα έγγραφο τύπου Standard, θα εμφανιστεί το 
ακόλουθο παράθυρο: 

 

 
Εικόνα 19: Έγγραφο τύπου Standard 

 

Ο χρήστης μπορεί να επιλέξει την λειτουργία του εγγράφου, μέσα από τις τρείς επιλογές στα 
αριστερά του παραθύρου καθώς επίσης και να προσαρμόσει το μέγεθος του παραθύρου. 
Αφού κάνει τα παραπάνω, επιλέγει το κουμπί ΟΚ και μπορεί να ξεκινήσει να σχεδιάζει την 
πολυμεσική εφαρμογή του. 

 

 

5.1.3 Η ΕΠΙΦΑΝΕΙΑ ΕΡΓΑΣΙΑΣ ΤΟΥ MEDIATOR 9  

Το παράθυρο του Mediator 9 αποτελείται από διάφορα δομικά στοιχεία: 
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Εικόνα 20: Επιφάνεια εργασίας Mediator 9 (Matchware, 2007) 

 

· Το κουμπί του Mediator: βρίσκεται στην πάνω αριστερή γωνία του παραθύρου, και 
εμπεριέχει εντολές που επηρεάζουν όλο το έγγραφο όπως: New, Open, Save, Export, 
Print, Close κλπ. 
 

· Quick Access Toolbar (Εργαλειοθήκη γρήγορης πρόσβασης): Είναι ένα στοιχείο του 
περιβάλλοντος διεπαφής του Microsoft Office 2007. Πρόκειται για μία 
προσαρμόσιμη γραμμή εργαλείων, που είναι διαθέσιμη ανά πάσα στιγμή ανεξάρτητα 
από την καρτέλα μενού. Από προεπιλογή, βρίσκεται στην επάνω αριστερή γωνία του 
παραθύρου Mediator, δίπλα από το κουμπί του Mediator. 
 

· Το κεντρικό μενού (Ribbon), είναι ακόμα ένα στοιχείο του περιβάλλοντος διεπαφής 
του Microsoft Office 2007. Βρίσκεται κάτω από την εργαλειοθήκη γρήγορης 
πρόσβασης και περιλαμβάνει όλες τις κύριες δραστηριότητες του Mediator. 
Περιλαμβάνει όλες τις απαραίτητες εντολές για γρήγορο σχεδιασμό του έγγραφου. 
 

·  Οι πίνακες του Mediator, εμφανίζονται από προεπιλογή στα αριστερά του 
παραθύρου. Τοποθετημένοι μαζί δίνουν μια πλήρη εικόνα του εγγράφου.  
 

· Ο χώρος εργασίας είναι η περιοχή που χρησιμοποιεί ο χρήστης για να σχεδιάσει το 
έργο του. 
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5.1.4 ΔΗΜΙΟΥΡΓΙΑ ΚΑΙ ΔΙΑΧΕΙΡΙΣΗ ΣΕΛΙΔΩΝ   

 

Δημιουργία Σελίδων 

 Η σελίδες είναι το θεμέλιο για κάθε έγγραφο Mediator. Εκεί τοποθετούνται όλα τα 
αντικείμενα που δημιουργεί ο χρήστης, και αποτελούν τον τρόπο  μέσω των οποίων ο 
χρήστης μπορεί να περιηγηθεί στο έγγραφο του. Όταν προστεθεί μια νέα σελίδα στο έγγραφο 
υπάρχουν δύο επιλογές: 

· Δημιουργία κενής σελίδας 
· Δημιουργία σελίδας βάσει προκαθορισμένης διάταξης σελίδας. 

 

Δημιουργία κενής σελίδας 

Μια καινούρια κενή σελίδα μπορεί να προστεθεί στο έγγραφο με τους ακόλουθους τρόπους: 

Ø Καρτέλα Home →Pages → New (επιλογή του εικονιδίου στο επάνω μέρος). 
Ø Καρτέλα Page → Page Setup → New (επιλογή του εικονιδίου στο επάνω μέρος). 
Ø Δεξί κλικ πάνω στην κενή περιοχή δημιουργίας του εγγράφου →New. 

Θα εμφανιστεί το παράθυρο New Page: 

 

 
Εικόνα 21: Νέα σελίδα 

 

Στο παράθυρο New Page ο χρήστης εισάγει το όνομα της σελίδας και από την επιλογή Color 
έχει την δυνατότητα να αλλάξει το χρώμα της σελίδας. 

Η επιλογή Color δίνει τη δυνατότητα στον χρήστη να επιλέξει ένα από τα χρώματα που 
εμπεριέχονται στο παράθυρο "Standard" ή να καθορίσει το χρώμα που επιθυμεί από την 
επιλογή "Custom".  
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Εικόνα 22: Παράθυρο χρωμάτων "Standard" 

 

 
Εικόνα 23: Παράθυρο χρωμάτων "Custom" 

 

Το χρώμα της σελίδας μπορεί να αλλάξει με τους ακόλουθους τρόπους: 

Ø Καρτέλα Home → Pages → Color. 
Ø Καρτέλα Page → Page Setup → Color. 
Ø Δεξί κλικ πάνω στην κενή περιοχή δημιουργίας του εγγράφου → Color. 

 

Δημιουργία σελίδας βάσει προκαθορισμένης διάταξης σελίδας 

Επιλέγοντας το βέλος που βρίσκεται στο κάτω μέρος του εικονιδίου New Page, 
εμφανίζονται οι συλλογές με τις ήδη υπάρχουσες προκαθορισμένες σελίδες. 
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Εικόνα 24: Επιλογή προκαθορισμένων σελίδων 

 

Όταν ο χρήστης εισάγει μια από τις προκαθορισμένες σελίδες στο έγγραφό του, 
τοποθετείται αμέσως μετά την τρέχουσα σελίδα. 

Στις προκαθορισμένες σελίδες υπάρχουν δυο διαφορετικές συλλογές: 

Ø Page Layouts:  Εδώ υπάρχει ένα σύνολο από έτοιμες σελίδες όπου ο χρήστης μπορεί 
να βάλει κατευθείαν στο έργο του, κερδίζοντας έτσι χρόνο από όλη την δουλειά που 
θα έκανε σχεδιάζοντας από μόνος του το έγγραφό του. Οι σελίδες μπορούν να 
προσαρμοστούν ανάλογα με τις επιθυμίες του χρήστη, προσθέτοντας ή αφαιρώντας 
κουμπιά. Ακόμα, υπάρχει δυνατότητα σύνδεσης των σελίδων, για την δημιουργία 
ενός ολοκληρωμένο ιστότοπο. Η χρήση των σελίδων είναι δωρεάν για πάνω από μια 
χρήση. 

Ø Dynamic Templates: Η κατηγορία αυτή περιέχει τέσσερις προσχεδιασμένες 
διαδραστικές σελίδες: Contents, Index, Search και History, όπου ο χρήστης μπορεί 
να εφαρμόσει στο έγγραφό του, για να ενσωματώσει τις αντίστοιχες 
λειτουργικότητες αυτόματα.  

 

Διαχείριση Σελίδων  

Στην καρτέλα Page → Page Setup υπάρχουν οι πιο σημαντικές λειτουργίες των σελίδων. 

 

 
Εικόνα 25: Εντολές διαχείρισης σελίδων 

 

Ο χρήστης μπορεί να αποκτήσει πρόσβαση στις εντολές διαχείρισης σελίδων και με τους 
ακόλουθους τρόπους: 
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Ø Καρτέλα Home → Pages. 
Ø Δεξί κλικ στην σελίδα που θέλει ο χρήστης στην Page List. 
Ø Δεξί κλικ στην επιφάνεια εργασίας (δίχως να επιλέξει κάποιο αντικείμενο). 

 

Όλες οι σελίδες που εμπεριέχονται στο έγγραφό βρίσκονται στην Page List, αριστερά από 
την επιφάνεια εργασίας. Μία σελίδα μπορεί εύκολα να επιλεχθεί από την λίστα απλά 
κάνοντας κλικ πάνω στην σελίδα. 

Αν η λίστα δεν είναι ενεργοποιημένη μπορεί να ενεργοποιηθεί με τους ακόλουθους τρόπους: 

Ø Καρτέλα View → Show/Hide → Page List. 
Ø Επιλέγοντας το πλήκτρο F8. 

 

 
Εικόνα 26: Page List  

 

Η Page List ακόμα, επιτρέπει στον χρήστη να αλλάξει τη σειρά των σελίδων μέσα στο έργο 
και δίνει πρόσβαση σε μερικές πρόσθετες εντολές. 

Ακόμα, παρέχετε η δυνατότητα δημιουργίας υποσέλιδων μέσα στις κύριες σελίδες με σκοπό 
την καλύτερη οργάνωση του εγγράφου. Το σήμα + δίπλα από το όνομα της σελίδας, 
υποδηλώνει ότι η σελίδα εμπεριέχει υποσελίδες μία ή και παραπάνω. Πατώντας το σήμα (+ ) 
εμφανίζονται οι υποσελίδες και στην συνέχειa πατώντας το σήμα – (όπου έχει μετατραπεί το 
σήμα + σε - ) αποκρύπτονται. 

 

Ιδιότητες σελίδων 

Όλες οι σελίδες έχουν έναν πίνακα ιδιοτήτων μέσα από τον οποίο μπορεί να γίνει 
οποιαδήποτε απαραίτητη αλλαγή. Αν ο πίνακας ιδιοτήτων δεν είναι ενεργοποιημένος μπορεί 
να ενεργοποιηθεί με τους ακόλουθους τρόπους: 
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Ø Καρτέλα Page → Page Setup → Properties. 
Ø Δεξί κλικ στην σελίδα που θέλει ο χρήστης στην Page List → Properties. 
Ø Πατώντας τα πλήκτρα Ctrl+F8. 

 

Διαγραφή σελίδας 

Ø Επιλογή της σελίδας από την Page List → καρτέλα Page → Page Setup → Delete. 
Ø Επιλογή της σελίδας από την Page List → καρτέλα Home → Pages → Delete. 
Ø Επιλογή της σελίδας από την Page List → δεξί κλικ → Delete. 
Ø Επιλογή της σελίδας από την Page List → επιλογή του πλήκτρου Delete. 

 

Μετονομασία σελίδας 

Ø Επιλογή της σελίδας από την Page List → καρτέλα Page → Page Setup → Rename. 
Ø Επιλογή της σελίδας από την Page List → καρτέλα Home → Pages → Rename. 
Ø Επιλογή της σελίδας από την Page List → δεξί κλικ → Rename. 

 

Αντιγραφή / Αποκοπή και Επικόλληση σελίδας 

Ø Επιλογή της σελίδας από την Page List → καρτέλα Home → Clipboard → Copy ή 
Cut. 

Ø Επιλογή της σελίδας από την Page List → καρτέλα Home → Clipboard → Paste. 
Ø Επιλογή της σελίδας από την Page List → δεξί κλικ → Copy ή Cut. 
Ø Επιλογή της σελίδας από την Page List → δεξί κλικ → Paste. 

 

Ορισμός κύριων σελίδων και υποσέλιδων σε μια σελίδα 

Με τέσσερις διαφορετικούς τρόπους μπορεί να γίνει ο ορισμός των κύριων σελίδων και των 
υποσέλιδων σε μια σελίδα: 

Ø Χρησιμοποιώντας  τις καρτέλες master page που βρίσκονται στα αριστερά στο τέλος 
της οθόνης. 

Ø Χρησιμοποιώντας  τον πίνακα ιδιοτήτων των σελίδων της εκάστοτε σελίδας. 
Ø Χρησιμοποιώντας τον  πίνακα ιδιοτήτων των σελίδων σε πολλαπλές σελίδες. 
Ø Αντιγράφοντας μια σελίδα όπου οι κύριες σελίδες έχουν ήδη οριστεί. 

 

Χρησιμοποιώντας  τις καρτέλες master page που βρίσκονται στα αριστερά στο τέλος της 
οθόνης:  

Ο χρήστης μπορεί να χρησιμοποιήσει τις καρτέλες master page  για να 
ορίσει κύριες σελίδες στην τρέχουσα σελίδα. Αφού ο χρήστης επιλέξει μια υποσελίδα ή μια 
κύρια σελίδα, δεν μπορεί να διαγράψει ή να επιλέξει μια διαφορετική κύρια σελίδα 
χρησιμοποιώντας αυτές τις καρτέλες. 
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Χρησιμοποιώντας  τον πίνακα ιδιοτήτων των σελίδων της εκάστοτε σελίδας: Για να επιλέξει 
ο χρήστης μια διαφορετική κύρια σελίδα, επιλέγει την καρτέλα Page → Page Setup → 
Properties και επιλέγει μια καινούρια σελίδα στον σχετικό φάκελο της κύριας σελίδας. Αν ο 
χρήστης θέλει να διαγράψει μια κύρια σελίδα απλά διαγράφει το αρχείο.  

 

Χρησιμοποιώντας τον  πίνακα ιδιοτήτων των σελίδων σε πολλαπλές σελίδες: Αν ο χρήστης 
επιθυμεί να συνδέσει την ίδια κύρια σελίδα σε πολλές σελίδες και δεν θέλει να επαναλάβει 
την ίδια διαδικασία για κάθε σελίδα ξεχωριστά, μπορεί να χρησιμοποιήσει την λειτουργία 
επεξεργασίας του Mediator:  

Ø Επιλογή όλων των σελίδων από την Page List που επιθυμεί ο χρήστης να συνδέσει 
την ίδια κύρια σελίδα. 

Ø Επιλογή της καρτέλας Page → Page Setup → Properties. 
Ø Επιλογή του αντίστοιχου κουμπιού της κύριας σελίδας (Top or Bottom). 
Ø Επιλογή της σελίδας που θέλει ο χρήστης να χρησιμοποιείτε ως κύρια σελίδα. 

 

Αντιγράφοντας μια σελίδα όπου οι κύριες σελίδες έχουν ήδη οριστεί: Εάν ο χρήστης έχει 
δημιουργήσει μια σελίδα και έχει συνδέσει μια ή παραπάνω κύριες σελίδες σ’ αυτήν, είναι 
πολύ εύκολο να δημιουργηθούν κι άλλες σελίδες οι οποίες θα χρησιμοποιούν τις ίδιες κύριες 
σελίδες, κάνοντας αντιγραφή και επικόλληση της σελίδας στην Page List.  

Ø Επιλογή της σελίδας που επιθυμεί ο χρήστης να αντιγράψει από την Page List. 
Ø Δεξί κλικ → Copy ή Ctrl + C. 
Ø Δεξί κλικ → Paste ή Ctrl + V. 
Ø Η διαδικασία συνεχίζετε μέχρι  να ολοκληρωθούν όλες οι σελίδες. 

 

5.1.5 ΔΗΜΙΟΥΡΓΙΑ ΚΑΙ ΔΙΑΧΕΙΡΙΣΗ ΑΝΤΙΚΕΙΜΕΝΩΝ  

 

Δημιουργία Αντικειμένων  

 Η καρτέλα Insert εμπεριέχει όλα τα αντικείμενα όπου μπορεί ο χρήστης να εισάγει 
στο έργο του. 

 
Εικόνα 27: Καρτέλα Insert  

 

Τα περισσότερα αντικείμενα μπορούν να εισαχθούν χρησιμοποιώντας της ίδια διαδικασία: 
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Ø Επιλογή του αντικειμένου από την καρτέλα Insert. Όταν μετακινηθεί ο δείκτης του 
ποντικιού μακριά από την καρτέλα, είναι εμφανές ότι το αντίστοιχο εργαλείο έχει 
ενεργοποιηθεί.  

Ø Στη συνέχεια, ο χρήστης δημιουργεί ένα πλαίσιο στην επιφάνεια εργασίας, στην θέση 
και στο μέγεθος που επιθυμεί να είναι το αντίστοιχο αντικείμενο. 

Για ορισμένα αντικείμενα αυτή η διαδικασία είναι αρκετή. Άλλα αντικείμενα χρειάζεται 
επιπλέον πληροφορίες από τον χρήστη. Για παράδειγμα, οι εικόνες και τα βίντεο απαιτούν 
από τον χρήστη να καθορίσει ένα όνομα αρχείου. Μόλις ο χρήστης αφήσει το κουμπί του 
ποντικιού, θα εμφανιστεί ένα παράθυρο το οποίο επιτρέπει στον χρήστη να περιηγηθεί στα 
αρχεία του υπολογιστή του, και να επιλέξει το αρχείο που επιθυμεί.   

Μόλις τοποθετηθεί το αντικείμενο στην επιφάνεια εργασίας, θα εμφανιστεί μια επιπλέον 
καρτέλα, η καρτέλα Format, ειδικά για το αντικείμενο αυτό, όπου ο χρήστης μπορεί να 
τροποποιήσει τις ιδιότητες του αντικειμένου.  

 

Διαχείριση Αντικειμένων  

Η Object List είναι πολύ σημαντική διότι δίνει μια ολοκληρωμένη εικόνα από όλα τα 
αντικείμενα που έχουν τοποθετηθεί στη σελίδα και είναι πιο εύκολο στον χρήστη να 
εντοπίσει το αντικείμενο που θέλει να διαχειριστεί. Ο χρήστης μπορεί να έχει πρόσβαση στις 
εντολές διαχείρισης των αντικειμένων και με τους ακόλουθους τρόπους: 

Ø Καρτέλα Home → Arrange. 
Ø Καρτέλα Home → Editing. 
Ø Δεξί κλικ στο αντικείμενο που θέλει ο χρήστης στην Object List. 
Ø Δεξί κλικ στο αντικείμενο που θέλει ο χρήστης στην επιφάνεια εργασίας. 

 

Όλα τα αντικείμενα που εμπεριέχονται στο έγγραφό βρίσκονται στην Object List, αριστερά 
από την επιφάνεια εργασίας. Ο χρήστης μπορεί εύκολα να επιλέξετε ένα αντικείμενο από την 
λίστα. Αν η λίστα δεν είναι ενεργοποιημένη μπορεί να ενεργοποιηθεί με τους ακόλουθους 
τρόπους: 

Ø Καρτέλα View → Show/Hide → Object List. 
Ø Επιλογή του πλήκτρου F4. 
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Εικόνα 28: Object List 

 

Τα αντικείμενα μπορούν να μετακινηθούν οπουδήποτε μέσα στην λίστα απλά επιλέγοντας 
το αντικείμενο και μεταφέροντας το αλλού μέσα στη λίστα. Κάθε αντικείμενο τοποθετείται 
ανά όνομα και εκπροσωπείται από το ίδιο εικονίδιο όπως στην καρτέλα Insert. Ακόμα, η 
Object List αντικατοπτρίζει την σειρά με την οποία έχουν τοποθετηθεί τα αντικείμενα στη 
σελίδα.  Η κίτρινη κουκίδα δίπλα από το όνομα του αντικειμένου σημαίνει ότι η 
διαδραστικότητα έχει οριστεί για το συγκεκριμένο αντικείμενο. 

 

Ιδιότητες αντικειμένων 

Όλα τα αντικείμενα έχουν έναν πίνακα ιδιοτήτων μέσα από τον οποίο μπορεί να γίνει 
οποιαδήποτε απαραίτητη αλλαγή. Αν ο πίνακας ιδιοτήτων δεν είναι ενεργοποιημένος μπορεί 
να ενεργοποιηθεί με τους ακόλουθους τρόπους: 

Ø Καρτέλα View → Show/Hide → Properties. 
Ø Δεξί κλικ πάνω στο αντικείμενο στην Object List → Properties. 
Ø Επιλέγοντας το πλήκτρο F12 

 

Διαγραφή αντικειμένου 

Ø Επιλογή του αντικειμένου από την Object List → καρτέλα Home → Editing → 
Delete. 

Ø Επιλογή του αντικειμένου από την Object List →  δεξί κλικ → Edit → Delete. 
Ø Επιλογή του αντικειμένου από την Object List → επιλογή του πλήκτρου Delete. 

 

 



 
46 

 

Μετονομασία αντικειμένου   

Ø Επιλογή του αντικειμένου από την Object List → δεξί κλικ → Rename. 
Ø Επιλογή του αντικειμένου από την Object list → επιλογή του πλήκτρου F2. 
Ø Κάνοντας διπλό κλικ πάνω στο αντικείμενο στην επιφάνεια εργασίας. 

 

Αντιγραφή/Αποκοπή και Επικόλληση αντικειμένου 

Ø Επιλογή του αντικειμένου από την Object List → καρτέλα Home → Clipboard → 
Copy ή Cut ( ή  Ctrl + C). 

Ø Επιλογή του αντικειμένου από την Object List → καρτέλα Home → Clipboard → 
Paste (ή  Ctrl + V). 

Ø Επιλογή του αντικειμένου από την Object List → δεξί κλικ → Edit → Copy ή Cut. 
Ø Επιλογή του αντικειμένου από την Object List → δεξί κλικ → Edit → Paste. 

 

Αντίγραφο αντικειμένου 

Για την δημιουργία ενός πανομοιότυπο αντικείμενου με το αρχικό ο χρήστης θα πρέπει να 
ακολουθήσει τα ακόλουθα βήματα: 

Ø Επιλογή του αντικειμένου από την Object List → Clipboard → Duplicate. 
Ø Επιλογή του αντικειμένου από την Object List → δεξί κλικ → Edit → Duplicate. 
Ø Επιλογή των πλήκτρων Ctrl + D. 

 

Διαμόρφωση αντικειμένων 

Τα αντικείμενα που δημιουργούνται στο Mediator, τοποθετούνται στην Object List με 
ιεραρχική σειρά. Το πρώτο αντικείμενο που δημιουργείτε τοποθετείται το τέλος της Object 
List πίσω από τα υπόλοιπα αντικείμενα, ενώ το τελευταίο αντικείμενο τοποθετείται στην 
αρχή μπροστά από τα υπόλοιπα αντικείμενα. 

 

 
Εικόνα 29: Εντολές διαμόρφωσης αντικειμένων 

 

Η σειρά των αντικειμένων μπορεί να αλλαχθεί εύκολα με τις εντολές ταξινόμησης. Για να 
αλλάξει ο χρήστης την σειρά ενός ή περισσότερων αντικειμένων, επιλέγει μια από τις 
ακόλουθες εντολές ταξινόμησης:  
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Ø Καρτέλα Home → Arrange ή καρτέλα Format. 
Ø Δεξί κλικ → Arrange. 

 

Arrange/ Bring to Front (Ctrl + F)   

 Τοποθετεί τα επιλεγμένα αντικείμενα μπροστά από τα υπόλοιπα αντικείμενα. 

 

Arrange/ Send to Back (Ctrl + B) 

 Τοποθετεί τα επιλεγμένα αντικείμενα πίσω από τα υπόλοιπα αντικείμενα. 

 

Arrange/ Bring Forward   

      Μετακινεί τα επιλεγμένα αντικείμενα μια θέση πάνω. 

 

Arrange/ Send Backward  

      Μετακινεί τα επιλεγμένα αντικείμενα μια θέση πίσω. 

 

Εισαγωγή Επικεφαλίδας και Κειμένου 

 

Εισαγωγή Επικεφαλίδας 

 Για την εισαγωγή επικεφαλίδας στο έγγραφο εφαρμόζεται η ακόλουθη διαδικασία: 

Ø Καρτέλα Insert → Text → Headline. 
Ø Σχεδιασμός πλαισίου με το ποντίκι στο σημείο που επιθυμεί ο χρήστης να 

τοποθετήσει την επικεφαλίδα στο έργο του. 
Ø Ο χρήστης πληκτρολογεί την επικεφαλίδα στο ακόλουθο πλαίσιο: 
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Εικόνα 30: Εισαγωγή επικεφαλίδας 

 

Ιδιότητες επικεφαλίδας 

Αφού εισαχθεί η επικεφαλίδα, ανοίγει η καρτέλα "Format", η οποία εμπεριέχει τις 
σημαντικότερες εντολές για την επεξεργασία επικεφαλίδων. 

 

 
Εικόνα 31: Εντολές επεξεργασίας επικεφαλίδας 

 

 

Εισαγωγή Κειμένου  

 Το αντικείμενο κειμένου επιτρέπει στον χρήστη να γράψει και να μορφοποιήσει 
κείμενο, να δημιουργήσει λίστες με κουκίδες και αριθμούς, να εισάγει πίνακες, να ορίσει 
υπερ-συνδέσμους, και να εκτελέσει πολλές ακόμα λειτουργίες στο κείμενο. 

Για την εισαγωγή κειμένου στο έγγραφο εφαρμόζεται η ακόλουθη διαδικασία: 

Ø Καρτέλα Insert → Text → Text. 
Ø Σχεδιασμός πλαισίου με το ποντίκι στο σημείο που επιθυμεί ο χρήστης να 

τοποθετήσει το κείμενο στο έργο του. 

 

Ιδιότητες Κειμένου 

Αφού εισαχθεί το κείμενο, ανοίγει η καρτέλα "Edit", η οποία εμπεριέχει τις 
σημαντικότερες εντολές για την επεξεργασία κειμένου: 
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Εικόνα 32: Εντολές επεξεργασίας κειμένου 

 

Εισαγωγή Εικόνας και Πολυγώνου 

 

Εισαγωγή Εικόνας  

  Το Mediator επιτρέπει στον χρήστη να εισάγει όλων των ειδών τις φωτογραφίες στο 
έργο του. Η εισαγωγή εικόνας στη σελίδα γίνετε με τον ακόλουθο τρόπο: 

Ø Καρτέλα Insert → Illustrations → Picture. 
Ø Σχεδιασμός πλαισίου με το ποντίκι στο σημείο που επιθυμεί ο χρήστης να 

τοποθετήσει την εικόνα στο έργο του. 
Ø Εμφάνιση του παραθύρου επιλογής φωτογραφίας. 
Ø Επιλογή εισαγωγής της φωτογραφίας. 

 

Αφού επιλεχθεί η φωτογραφία εμφανίζεται το παράθυρο προσαρμογής μεγέθους της 
φωτογραφίας. Αυτό το παράθυρο, επιτρέπει στον χρήστη να ρυθμίσει αυτόματα το μέγεθος 
του πλαισίου της φωτογραφίας ώστε να ταιριάζει στην εικόνα 

. 

Εικόνα 33: Επιλογές μεγέθους εικόνας 

 

Επιλέγοντας της εντολή "Use as background picture" το μέγεθος της εικόνας προσαρμόζεται 
αυτόματα στο μέγεθος του έργου. 
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Ιδιότητες φωτογραφίας 

Αφού εισαχθεί η εικόνα, ανοίγει η καρτέλα "Format", η οποία εμπεριέχει τις σημαντικότερες 
εντολές για την επεξεργασία εικόνων. 

 

 
Εικόνα 34: Εντολές επεξεργασίας εικόνας 

 

 

Εισαγωγή Πολυγώνου 

 Το Mediator επιτρέπει στον χρήστη εκτός από πολύγωνα να δημιουργήσει γραμμές, 
κύκλους, καμπύλες κλπ. Η διαδικασία εισαγωγής πολυγώνου δεν είναι η ίδια με τα υπόλοιπα 
αντικείμενα. Επιλογή της καρτέλας Insert → Illustrations → Polygon. 

Υπάρχουν δύο επιλογές: 

Ø Επιλέγοντας το βέλος στο κάτω μέρος του εικονιδίου ο χρήσης μπορεί να 
επιλέξει ένα προσχεδιασμένο πολύγωνο μέσα από μια μεγάλη συλλογή σχεδίων. 
 

 
Εικόνα 35: Επιλογές προσχεδιασμένων πολυγώνων 

 

Σχεδιασμός πλαισίου με το ποντίκι στο σημείο που επιθυμεί ο χρήστης να τοποθετήσει το 
σχήμα στο έργο του. 
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Ø Επιλέγοντας το εικονίδιο  στο επάνω μέρος, ο χρήστης έχει την δυνατότητα να 
σχεδιάσει το σχήμα που επιθυμεί στη σελίδα. Θα εμφανιστεί η καρτέλα "Edit" έτσι 
ώστε να γίνει επεξεργασία στο σχήμα. 
 

 
Εικόνα 36: Επεξεργασία σχήματος πολυγώνου 

 

 Με το εικονίδιο "Add Point" το οποίο είναι ενεργοποιημένο από προεπιλογή, ο 
χρήστης μπορεί να σχεδιάσει ένα πολύγωνο βάζοντας σημεία πάνω στην σελίδα. Για να 
τοποθετηθεί ένα σημείο στη σελίδα, ο χρήστης μετακινεί το ποντίκι στο σημείο που θέλει, 
κάνοντας κλικ και αφήνοντας το ποντίκι. 

Μόλις εμφανιστεί ένα κόκκινο πλαίσιο  πάνω στη σελίδα, ο χρήστης συνεχίζει 
κάνοντας κλικ σε ένα άλλο σημείο της σελίδας. Το πρώτο σημείο αλλάζει σε γκρι και το νέο 
σημείο έχει τον κύκλο με το κόκκινο πλαίσιο, που σημαίνει ότι είναι ενεργό. Μια μπλε 

γραμμή ενώνει τα σημεία.  

Όταν ολοκληρωθεί η επεξεργασία του πολυγώνου, ο χρήστης επιλέγει: Editing → Close 
ώστε να κλείσει η επιλογή επεξεργασίας. 

 

Τα εργαλεία επεξεργασίας του πολυγώνου περιγράφονται παρακάτω: 

 

 
Εικόνα 37: Εργαλεία επεξεργασίας πολυγώνου 

 

Τα εικονίδια του Point γκρουπ επιτρέπουν στον χρήστη να δημιουργήσει πολύγωνο 
τοποθετώντας σημεία στην σελίδα. 
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 Το εικονίδιο "Select" επιτρέπει στον χρήστη να επιλέξει ένα υπάρχον σημείο στην 
σελίδα και να το μετακινήσει. 

 Το εικονίδιο "Add" επιτρέπει στον χρήστη να προσθέσει ένα καινούριο σημείο. 

    Με το εικονίδιο "Delete" ο χρήστης μπορεί να διαγράψει ένα σημείο. 

   Το εικονίδιο "Grid" ενεργοποιεί τον πίνακα. 

 

Η επόμενη ομάδα εικονιδίων επιτρέπει στον χρήστη να δημιουργήσει καμπύλες εκτός από 
ευθείες γραμμές. 

 
Εικόνα 38: Εργαλεία δημιουργίας καμπύλων 

  Το εικονίδιο "Break" είναι διαθέσιμο μόνο όταν το πολύγωνο είναι ενωμένο. Για να 
ανοίξει, ο χρήστης διαλέγει ένα σημείο και επιλέγει το συγκεκριμένο εικονίδιο. 

  Το εικονίδιο "To Symmetric Bezier" είναι ενεργοποιημένο όταν τουλάχιστον ένα 
από τα σημεία είναι επιλεγμένο. Επιτρέπει στον χρήστη να μετατρέψει τις έντονες γωνίες 
μεταξύ των γραμμών σε καμπύλες. 

  Το εικονίδιο "To Bezier" είναι παρόμοιο με το εικονίδιο "To Symmetric Bezier", με 
την διαφορά ότι με το εικονίδιο "To Bezier" επιτρέπει στον χρήστη να αλλάζει την κάθε 
πλευρά της καμπύλης ανεξάρτητα.  

 Το εικονίδιο "To Line" επιτρέπει στον χρήστη να αφαιρέσει τις καμπύλες που 
δημιούργησε.   
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 Με την επιλογή "Close" τερματίζει η λειτουργία επεξεργασίας πολυγώνου. 

 

 

Ιδιότητες πολυγώνου 

Αφού εισαχθεί το πολύγωνο, ανοίγει η καρτέλα "Format", η οποία εμπεριέχει τις 
σημαντικότερες εντολές για την επεξεργασία πολυγώνου. 

 

 
Εικόνα 39: Εντολές επεξεργασίας πολυγώνου 

 

Εισαγωγή Windows Media Player και Animated GIF 

 

  Το αντικείμενο Media Player επιτρέπει στον χρήστη να αναπαράγει βίντεο και ήχο, σε 
ένα παράθυρο Media Player που έχει τοποθετηθεί στην σελίδα. Η χρήση του Media Player 
έχει τα ακόλουθα πλεονεκτήματα: 

Ø Υποστηρίζεται από όλες τις κοινές μορφές Windows. 
Ø Διατίθεται σε έγγραφα τύπου HTML. 
Ø Επιτρέπει στον χρήστη να χρησιμοποιήσει τους δείκτες που έχουν τοποθετηθεί στα 

αρχεία πολυμέσων, για να εξασφαλίσει το τέλειο χρονισμό με άλλα διαδραστικά 
στοιχεία. 

 

Ο χρήστης μπορεί να εισάγει το βίντεο ή τον ήχο που επιθυμεί με τον ακόλουθο τρόπο: 

Ø Καρτέλα Insert → Media Clips → Media Player. 
Ø Σχεδιασμός πλαισίου με το ποντίκι στο σημείο που επιθυμεί ο χρήστης να 

τοποθετήσει την σχήμα στο έργο του. 
Ø Μόλις ο χρήστης αφήσει το κουμπί του ποντικιού, θα εμφανιστεί ένα παράθυρο το 

οποίο επιτρέπει στον χρήστη να περιηγηθεί στα αρχεία του υπολογιστή του, και να 
επιλέξει το αρχείο που επιθυμεί.   

Ø Όταν επιλέξει το βίντεο ή τον ήχο εμφανίζεται το ακόλουθο πλαίσιο: 
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Εικόνα 40: Εισαγωγή αντικειμένου Windows Media Player 

 

 

Ιδιότητες αντικειμένου Media player 

Αφού εισαχθεί ο ήχος στο έγγραφο, ανοίγει η καρτέλα "Format", η οποία εμπεριέχει τις 
σημαντικότερες εντολές για την επεξεργασία ήχου. 

 

 
Εικόνα 41: Εντολές επεξεργασίας ήχου 

 

Εισαγωγή Animated GIF 

 Το αντικείμενο Animated GIF επιτρέπει στον χρήστη να εισάγει στην σελίδα 
κινούμενα αρχεία GIF. Ο χρήστης μπορεί να εισάγει ένα Animated GIF με τον ακόλουθο 
τρόπο: 

Ø Καρτέλα Insert → Media Clips → Animated GIF. 

Για την εισαγωγή κινούμενων αντικειμένων GIF δεν χρειάζεται ο σχεδιασμός ορθογώνιου 
πλαισίου για την εισαγωγή τους στη σελίδα. Τα κινούμενα αντικείμενα GIF, διατηρούν πάντα 
το αρχικό τους μέγεθος και δεν μπορούν να τροποποιηθούν, σε αντίθεση με τις εικόνες και τα 
βίντεο. 

Ø Το παράθυρο που θα εμφανιστεί, επιτρέπει στον χρήστη να περιηγηθεί στα αρχεία του 
υπολογιστή του, και να επιλέξει το αρχείο GIF που επιθυμεί.   
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Ιδιότητες Animated GIF 

Αφού εισαχθεί το κινούμενο αντικείμενο GIF στο έγγραφο, ανοίγει η καρτέλα "Format", η 
οποία εμπεριέχει τις σημαντικότερες εντολές για την επεξεργασία των αντικειμένων GIF. 

 

 
Εικόνα 42: Εντολές επεξεργασίας αντικειμένων GIF 

 

Εισαγωγή Κουμπιών και Animation Path 

 

Εισαγωγή Κουμπιών 

 Η δημιουργία κουμπιών με το Mediator 9 είναι εύκολη και γρήγορη διαδικασία. Ο 
χρήστης μπορεί να εισάγει ένα κουμπί  με τον ακόλουθο τρόπο: Επιλογή της καρτέλα Insert 
→ Controls → Button. 

Υπάρχουν δύο επιλογές: 

Ø Επιλέγοντας το εικονίδιο  στο επάνω μέρος, ο χρήστης έχει την δυνατότητα να 
σχεδιάσει ένα προκαθορισμένο κουμπί στη σελίδα. 

Ø Επιλέγοντας το βέλος στο κάτω μέρος του εικονιδίου  ο χρήσης μπορεί να 
επιλέξει ένα προσχεδιασμένο κουμπί μέσα από μια μεγάλη συλλογή σχεδίων. 

 
Εικόνα 43: Επιλογές προσχεδιασμένων κουμπιών 
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Σχεδιασμός πλαισίου με το ποντίκι στο σημείο που επιθυμεί ο χρήστης να τοποθετήσει το 
κουμπί στη σελίδα. 

Ø Αν έχει δημιουργήσει ένα προκαθορισμένο κουμπί η λειτουργία επεξεργασίας γίνετε 
αμέσως και επιτρέπει στον χρήστη να αλλάξει το προκαθορισμένο κείμενο πάνω στο 
κουμπί. Διαφορετικά, η λειτουργία επεξεργασίας εισάγετε με διπλό κλικ πάνω στο 

κουμπί.  

 

Ιδιότητες κουμπιών 

Αφού εισαχθεί το κουμπί στο έγγραφο, ανοίγει η καρτέλα "Format", η οποία εμπεριέχει τις 
σημαντικότερες εντολές για την επεξεργασία των κουμπιών. 

 

 

 
Εικόνα 44: Εντολές επεξεργασίας κουμπιών 

 

Εισαγωγή Animation Path 

  Το εργαλείο Animation Path επιτρέπει στον χρήστη να δημιουργήσει μια διαδρομή με 
κινούμενα αντικείμενα και να τοποθετήσει κατά μήκος ένα ή και περισσότερα αντικείμενα.  

Η διαδικασία δημιουργίας Animation Path είναι σχεδόν ίδια με την δημιουργία πολυγώνου, 
καθώς και τα δύο περιέχουν σημεία όπου ενώνονται, γραμμές και καμπύλες. 

Η καρτέλα Edit του Animation Path είναι σχεδόν ίδια με αυτή του πολυγώνου. Η μόνη 
διαφορά είναι στο πεδίο "Browse Object", όπου επιτρέπει στον χρήστη να δει πως θα μοιάζει 
το αντικείμενο που σκοπεύει να δημιουργήσει σε κάθε σημείο στο Animation Path. 
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Εικόνα 45: Animation Path  

 

Ιδιότητες Animation Path 

Αφού ο χρήστης εισάγει το Animation Path στο έγγραφο, ανοίγει η καρτέλα "Format", η 
οποία εμπεριέχει τις σημαντικότερες εντολές για την επεξεργασία του Animation Path. 

 

 
Εικόνα 46: Εντολές επεξεργασίας Animation Path 

 

 

5.1.6 ΔΗΜΙΟΥΡΓΙΑ ΔΙΑΔΡΑΣΤΙΚΟΤΗΤΑΣ  

 Εφόσον ο χρήστης έχει δημιουργήσει τις σελίδες, το επόμενο και τελευταίο βήμα 
είναι να δημιουργήσει διαδραστικότητα μεταξύ των σελίδων. Αυτό θα το επιτύχει με την 
χρήση του παραθύρου Events. Το παράθυρο Events είναι αυτό που καθιστά το Mediator τόσο 
ισχυρό. Επιτρέπει στον χρήστη με την "drag and drop" λειτουργία, να δημιουργεί 
εντυπωσιακές παρουσιάσεις δίχως καμία γνώση προγραμματισμού.  
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Το πρώτο που πρέπει να κάνει ο χρήστης, είναι να συνδέσει  τη Cruises με την Cruises1. 
Αυτό μπορεί να το επιτύχει με τον ακόλουθο τρόπο: 

· Επιλογή της Cruises από την Page List, και στη συνέχεια επιλογή του κουμπιού που 
είχε δημιουργήσει νωρίτερα στην Cruises. 
 

· Επιλογή του κουμπιού στη Page1 κάνοντας αριστερό κλικ πάνω στο κουμπί. 

Πρέπει να προγραμματιστεί το κουμπί, έτσι ώστε όταν ο χρήστης κάνει κλικ πάνω στο 
κουμπί να οδηγεί στη Cruises1. Για να εφαρμοστεί αυτή η λειτουργία πρέπει να 
χρησιμοποιηθεί τι παράθυρο Events. 

·  Δεξί κλικ πάνω στο κουμπί και επιλογή της ενέργειας Events από το μενού που θα 
εμφανιστεί. 

Εμφανίζεται το παράθυρο Events όπου και θα χρησιμοποιηθεί για τον προγραμματισμό του 
κουμπιού. 

 

 
Εικόνα 47: Παράθυρο διαδραστικότητας- Events 

 

Στην αριστερή πλευρά του παραθύρου Events, εμφανίζεται η λίστα όλων των πιθανών 
συμβάντων. Ένα event είναι κάτι που μπορεί να συμβεί σε ένα αντικείμενο. Στην κορυφή του 
παραθύρου Events εμφανίζεται η λίστα με όλες τις πιθανές ενέργειες. Μια ενέργεια είναι κάτι 
που ενεργοποιείται από ένα event όπως για παράδειγμα η αναπαραγωγή ενός ήχου κλπ. 

Η δημιουργία διαδραστικότητας στο παράθυρο Events συνίσταται πάντοτε στο συνδυασμό 
τουλάχιστον ενός event με μια ή περισσότερες ενέργειες.  

Για να υπάρχει δυνατότητα το κουμπί να πηγαίνει στην Cruises1 πρέπει να συνδυαστούν το 
event Mouse Click με την ενέργεια Go to Page. 
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· Αφού επιλεχθεί το event Mouse Click  στη συνέχεια  σύρετε στη μεγάλη κενή 
επιφάνεια που ονομάζεται ενεργό πεδίο. 

· Στη συνέχεια, επιλέγεται η ενέργεια Go to Page   και σύρετε στη μεγάλη κενή 
επιφάνεια δεξιά του event Mouse Click. 

Μόλις ολοκληρωθεί η ενέργεια εμφανίζεται το παράθυρο Go to Page. 

 
Εικόνα 48: Παράθυρο Go to Page 

 

Αυτό το παράθυρο επιτρέπει στον χρήστη να επιλέξει τη σελίδα στην οποία θέλει να 
μεταβαίνει όταν κάνει κλικ στο κουμπί. Κάθε φορά που ο χρήστης σύρει μια ενέργεια Go to 
Page στο ενεργό πεδίο, το παράθυρο διαλόγου Go to Page ανοίγει αυτόματα μια λίστα 
σελίδων. 

· Επιλογή της Cruises1 από την λίστα σελίδων που εμφανίζονται και κλικ στο κουπί 
ΟΚ. 

 

Το εικονίδιο Mouse Click είναι αμετάβλητο, αλλά το εικονίδιο Go to Page τώρα φέρει την 
ένδειξη "Cruises1", υποδεικνύοντας ότι το κουμπί έχει προγραμματιστεί να μεταβαίνει στην 
Cruises1 όταν ο χρήστης κάνει αριστερό κλικ στο κουμπί. 
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 Εικόνα 49: Παράθυρο Event 

5.1.7 ΔΟΚΙΜΗ ΕΓΓΡΑΦΟΥ  

Ακόμα και ο πιο έμπειρος χρήστης είναι πολύ πιθανό να κάνει κάποιο λάθος κατά τον 
σχεδιασμό του έργου του. Για παράδειγμα, μπορεί ο χρήστης να καθορίσει κάποιο εσφαλμένο 
Animation Path κλπ. Στην καρτέλα Review → Test group, περιέχει διάφορα εργαλεία τα 
οποία βοηθούν τον χρήστη να ελέγξει αν το έγγραφο του λειτουργεί σωστά. (Matchware, 
2007)  

 Run Document (F5) 

Η επιλογή "Run Document", ξεκινά μια προεπισκόπηση εκτέλεσης του έργου, αρχίζοντας 
από την πρώτη σελίδα της Page List. Η λειτουργία δοκιμής τερματίζει με το πλήκτρο Esc, 

 

   Run Page (F6) 

Η επιλογή "Run Page", είναι παρόμοια με την επιλογή "Run Document" μόνο που εδώ η 
προεπισκόπηση εκτέλεσης ξεκινά από την τρέχουσα σελίδα. 

 

   Preview Page (Shift + F6) 

Η επιλογή "Preview Page", εφαρμόζεται μόνο στα έγγραφα τύπου HTML ή Flash, και 
παρέχει μια πραγματική προεπισκόπηση της τρέχουσας σελίδας στο προεπιλεγμένο 
πρόγραμμα περιήγησης στο Internet.  
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  Check Document (F11)  

Η επιλογή "Check Document", ελέγχει ολόκληρο το έγγραφο για σφάλματα, όπως αρχεία 
που λείπουν, σύνδεσμοι που λείπουν κλπ. 

 

  Check Page (Ctrl + F11) 

Η επιλογή "Check Page", ελέγχει την τρέχουσα για σφάλματα, όπως αρχεία που λείπουν, 
σύνδεσμοι που λείπουν κλπ.  

 

5.2 ΠΡΟΓΡΑΜΜΑ WINDOWS MOVIE MAKER 

  Το Windows Movie Maker χρησιμοποιήθηκε στην επεξεργασία των βίντεο που 
εμπεριέχονται στην εφαρμογή. Είναι ένα λογισμικό που επιτρέπει στον χρήστη να 
δημιουργήσει και να επεξεργαστεί βίντεο. Κατασκευάζεται από την Microsoft Windows και 
διατίθεται δωρεάν. Το Windows Movie Maker, είναι ήδη εγκατεστημένο στον υπολογιστή 
και επιτρέπει στον χρήστη να δημιουργήσει ταινίες με τίτλους, εφέ, μουσική, αφήγηση κλπ.  

Το Windows Movie Maker σχεδιάστηκε να είναι εύκολο στη χρήση ακόμα και για κάποιον 
που δεν έχει χρησιμοποιήσει ξανά κάποιο πρόγραμμα επεξεργασίας βίντεο. (Tech - ease, 
2018), (steves-digicams, 2018).  

 

 
Εικόνα 50: Επιφάνεια εργασίας Windows Movie Maker 
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Περιγραφή επιφάνειας εργασίας του Windows Movie Maker: 

· Menu Tools: περιέχει όλες τις σημαντικές εντολές επεξεργασίας. 
· Storyboard: βρίσκεται στα δεξιά της οθόνης και δείχνει το βίντεο σαν ταινία φιλμ. 
· Video Preview: βρίσκεται στα αριστερά της οθόνης. 

 

Εισαγωγή βίντεο 

   Για την εισαγωγή βίντεο στο πρόγραμμα Windows Movie Maker, ο 
χρήστης επιλέγει το «Προσθήκη βίντεο και φωτογραφιών» στο Κεντρικό μενού. Στη 
συνέχεια θα εμφανιστεί ένα παράθυρο το οποίο επιτρέπει στον χρήστη να περιηγηθεί στα 
αρχεία του υπολογιστή του, και να επιλέξει το αρχείο που επιθυμεί.  

 

Επεξεργασία βίντεο  

Ø Επιλέγοντας την καρτέλα «Επεξεργασία – Edit» ο χρήστης μπορεί να κάνει περικοπή 
σε κάποια κομμάτια του βίντεο τα οποία δεν επιθυμεί να παραμείνουν. 

 

 
Εικόνα 51: Εργαλείο περικοπής βίντεο 

 
Ø Αφού επιλέξει το εργαλείο περικοπής, εμφανίζεται το ακόλουθο παράθυρο: 

 

 
Εικόνα 52: Περικοπή βίντεο 
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Μέσα από τις επιλογές «Σημείο έναρξης» και «Σημείο λήξης» ο χρήστης ορίζει τα κομμάτια 
του βίντεο, τα οποία θέλει να αποκόψει. Στη συνέχεια επιλέγει «Αποθήκευση περικοπής» και 
τέλος «Άκυρο» για να κλείσει την επιλογή περικοπής. 

 

Αποθήκευση βίντεο 

  Για την αποθήκευση βίντεο στο πρόγραμμα Windows Movie Maker, ο 
χρήστης επιλέγει το «Αποθήκευση ταινίας» στο Κεντρικό μενού. Στη συνέχεια από τις 
επιλογές που εμφανίζονται θα επιλέξει « Για υπολογιστή». 

 

5.3 ΕΞΑΓΩΓΗ ΕΓΓΡΑΦΟΥ ΣΤΟ MEDIATOR 9  

 Το Mediator επιτρέπει στον χρήστη να εξάγει το έργο του σε διάφορες μορφές, 
παρέχοντας την δυνατότητα διανομής και σε άλλους χρήστες. Οι διαθέσιμες μορφές 
εξαγωγής εξαρτώνται από τον τύπου του εγγράφου: Standard, HTML, Flash. Μόλις ο 
χρήστης επιλέξει την μορφή εξαγωγής, το Mediator ξεκινάει έλεγχο στο έργο για τον 
εντοπισμό τυχόν σφαλμάτων που μπορεί να υπάρχουν.  

Το Mediator αποθηκεύει την εξαγόμενη έκδοση στον φάκελο εξόδου που έχει καθορίσει ο 
χρήστης από πριν. (Matchware, 2007)  

 

 

5.4 ΜΟΡΦΕΣ ΕΞΑΓΩΓΗΣ  
Οι διάφορες μορφές εξαγωγής που διαθέτει το Mediator 9 είναι οι ακόλουθες: 

· CD-ROM (without installation) 
Αυτή η επιλογή είναι διαθέσιμη μόνο για έργα τύπου Standard. Με αυτή τη μορφή 
εξαγωγής όλα τα αρχεία του έργου αντιγράφονται στο CD-ROM όπου και 
παραμένουν. Κανένα από τα αρχεία του έργου δεν αντιγράφονται στον σκληρό δίσκο 
του τελικού χρήστη. Ακόμα, αυτή η μορφή εξαγωγής είναι καλή επιλογή για μεγάλα 
έργα τα οποία περιέχουν πολλές εικόνες, βίντεο, ήχο κλπ.  
 

· CD-ROM (with installation)  
Αυτή η επιλογή είναι διαθέσιμη μόνο στην επιλογή εξαγωγής Advanced για έργα 
τύπου Standard. Όπως και στην μορφή εξαγωγής CD-ROM (without installation),  
έτσι και με αυτή τη μορφή εξαγωγής όλα τα αρχεία του έργου αντιγράφονται στο 
CD-ROM όπου και παραμένουν. Η διαφορά με την προηγούμενη μορφή εξαγωγής 
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είναι ότι ο τελικός χρήστης για να δει το έργο θα πρέπει να το αντιγράψει στον 
σκληρό δίσκο του υπολογιστή του. 
 

· Εξαγωγή ως αρχείο EXE με δυνατότητα αυτόματης εκτέλεσης 
Ατός ο τρόπος επιλέχθηκε για την δημιουργία της εφαρμογής. Αυτή η επιλογή είναι 
διαθέσιμη μόνο για έργα τύπου Standard. Με αυτή τη μορφή εξαγωγής όλα τα 
αρχεία του έργου είναι ενσωματωμένα σε ένα αυτό-εκτελέσιμο αρχείο 
χρησιμοποιώντας το όνομα του έργου ως όνομα αρχείου. Όταν ο τελικός χρήστης 
κάνει διπλό κλικ στο αρχείο .exe για να εκτελέσει το έργο, αντί να αποσυμπιεστεί τα 
αρχεία διαβάζονται απευθείας από το αρχείο .exe. Αυτό εξασφαλίζει την βέλτιστη 
ταχύτητα εκτέλεσης ανεξάρτητα από το μέγεθος του αρχείου.   
 

· Εξαγωγή ως αρχείο Zip'N'Run 
Αυτή η επιλογή είναι διαθέσιμη μόνο στην επιλογή εξαγωγής Advanced για έργα 
τύπου Standard. Με αυτή τη μορφή εξαγωγής όλα τα αρχεία του έργου είναι 
συμπιεσμένα και αποθηκευμένα σε ένα αυτό-εκτελέσιμο αρχείο (.exe) 
χρησιμοποιώντας το όνομα του έργου ως όνομα αρχείου. Ο τελικός χρήστης για να 
εκτελέσει το έργο πρέπει να κάνει διπλό κλικ στο αρχείο .exe. Αυτό εξάγει τα αρχεία 
του έργου σε ένα προσωρινό στον σκληρό δίσκο, από τον οποίο εκτελείται το έργο. 
Όταν ο χρήστης βγει από το έργο, όλα τα αρχεία εκτός από το αρχείο .exe 
διαγράφονται από τον σκληρό δίσκο. Αυτή η μορφή εξαγωγής συνίσταται για μικρά 
έργα. Το πλεονέκτημα αυτής της μεθόδου είναι ότι κρυπτογραφεί όλα τα αρχεία, 
διατηρώντας ασφαλή τα αρχεία από ανεπιθύμητη πρόσβαση. 
 
 

Λειτουργίες εξαγωγής 

Ορισμένες από τις λειτουργίες εξαγωγής που αναφέρονται πιο πάνω μπορούν να 
χρησιμοποιηθούν σε δυο λειτουργίες: 

· Quick Export 
 

 Η λειτουργία εξαγωγής "Quick Export" επιτρέπει στον χρήστη να εξάγει 
γρήγορα το έργο του, χρησιμοποιόντας τις προεπιλογές Mediator. 
 

· Advanced Export 
 

  Η λειτουργία εξαγωγής " Advanced Export" επιτρέπει στον χρήστη να ορίσει 
διάφορες ρυθμίσεις εξαγωγής στο παράθυρο εξαγωγής. (Matchware, 2007).  
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6. Η ΟΛΟΚΛΗΡΩΜΕΝΗ ΕΦΑΡΜΟΓΗ  
Σε αυτό το κεφάλαιο θα γίνει η παρουσίαση της πολυμεσικής εφαρμογής "SeaCruises". Η  

"SeaCruises" είναι μια εικονική ναυτιλιακή εταιρία με έδρα το Κατάκολο Ηλείας, και μέσα 
από την πολυμεσική εφαρμογή στοχεύει στην ανάδειξη της περιοχής και στην αύξηση του 
τουρισμού. 

 

 
Εικόνα 53: Λογότυπο εταιρίας 

 

Ξεκινώντας την εφαρμογή, εμφανίζεται η αρχική εικόνα καλωσορίσματος: 

 

 
Εικόνα 54: Αρχική οθόνη 

 

Η εφαρμογή είναι δομημένη ως εξής: στο πάνω μέρος της οθόνης βρίσκεται το λογότυπο 
της εταιρίας, στα αριστερά της οθόνης υπάρχει το μενού πλοήγησης στην εφαρμογή, πάνω 
αριστερά υπάρχει μια κινούμενη εικόνα (Animated GIF) και στο κέντρο είναι ο χώρος που 
εμφανίζονται όλες οι πληροφορίες της εφαρμογής ανάλογα με την κατηγορία που έχει 
επιλέξει ο χρήστης να δει. Επιλέγοντας το κουμπί " Έξοδος" ο χρήστης εγκαταλείπει την 
εφαρμογή.  
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Το μενού πλοήγησης είναι το ακόλουθο: 

 
Εικόνα 55: Μενού πλοήγησης 

 

Στο μενού Αξιοθέατα υπάρχουν τα μέρη που μπορεί να επισκεφτεί ο επισκέπτης στο 
Κατάκολο όπως παρουσιάζονται παρακάτω: 

 
Εικόνα 56: Μενού Αξιοθέατα 
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Στο μενού Αξιοθέατα υπάρχουν τέσσερις υποκατηγορίες οι οποίες με την σειρά τους 
εμπεριέχουν η κάθε μια ξεχωριστά επιπλέον πληροφορίες σχετικά με το αξιοθέατο που έχει 
επιλέξει ο χρήστης να δει. Στα δεξιά υπάρχει μια κινούμενη εικόνα Animated GIF. Για να 
εισέλθει ο χρήστης στις πληροφορίες του αξιοθέατου, επιλέγει το κουμπί (βέλος) που 
βρίσκεται στα αριστερά του αξιοθέατου.  

Οι πληροφορίες της κάθε υποκατηγορίας του μενού Αξιοθέατα παρουσιάζοντα με τη σειρά 
παρακάτω: 

 
Εικόνα 57: Υποκατηγορία Αξιοθέατα 

 

 
Εικόνα 58: Υποκατηγορία Αξιοθέατα 
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Εικόνα 59: Υποκατηγορία Αξιοθέατα 

 

 
Εικόνα 60: Υποκατηγορία Αξιοθέατα 

 

 Όλες οι υποκατηγορίες στο μενού Αξιοθέατα, περιέχουν ένα κουμπί "Πίσω" το οποίο 
οδηγεί στο μενού Αξιοθέατα. 

 

Στο μενού Καράβι εμπεριέχονται όλες οι πληροφορίες σχετικά με το καράβι της εταιρίας: 
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Εικόνα 61: Μενού Καράβι 

Στο μενού Καράβι υπάρχουν δύο υποκατηγορίες οι οποίες με την σειρά τους εμπεριέχουν η 
κάθε μια ξεχωριστά επιπλέον πληροφορίες σχετικά με το καράβι, τις παροχές και τα 
πλεονεκτήματά του. Για να εισέλθει ο χρήστης στις πληροφορίες του Καραβιού, επιλέγει το 
κουμπί (βέλος) που βρίσκεται στα αριστερά της υποκατηγορίας.  

Οι πληροφορίες της κάθε υποκατηγορίας του μενού Καράβι παρουσιάζοντα με τη σειρά 
παρακάτω: 

 
Εικόνα 62: Υποκατηγορία Καράβι 
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Εικόνα 63: Υποκατηγορία Καράβι 

 Όλες οι υποκατηγορίες στο μενού Αξιοθέατα, περιέχουν ένα κουμπί "Πίσω" το οποίο 
οδηγεί στο μενού Καράβι. 

Στο μενού Κρουαζιέρες υπάρχουν τρείς υποκατηγορίες οι οποίες με την σειρά τους 
εμπεριέχουν η κάθε μια ξεχωριστά επιπλέον πληροφορίες σχετικά με την περιοχή που 
πραγματοποιείται η κρουαζιέρα. Κάτω δεξιά υπάρχει μια κινούμενη εικόνα Animated GIF. 
Για να εισέλθει ο χρήστης στις πληροφορίες του μενού Κρουαζιέρας, επιλέγει το κουμπί 
(βέλος) που βρίσκεται στα αριστερά της υποκατηγορίας. 

 

 
Εικόνα 64: Μενού Κρουαζιέρες 
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Οι πληροφορίες της κάθε υποκατηγορίας του μενού Κρουαζιέρες παρουσιάζοντα με τη 
σειρά παρακάτω: 

 

 
Εικόνα 65: Υποκατηγορία Καράβι 

 
Εικόνα 66: Υποκατηγορία Καράβι 
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Εικόνα 67: Υποκατηγορία Καράβι 

 

Όλες οι υποκατηγορίες στο μενού Αξιοθέατα, περιέχουν ένα κουμπί "Πίσω" το οποίο οδηγεί 
στο μενού Κρουαζιέρες. 

Στο μενού Φωτογραφίες υπάρχουν φωτογραφίες σχετικές με την περιοχή του Κατακόλου.  

 

 
Εικόνα 68: Μενού Φωτογραφίες 
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Στο μενού Κατάκολο υπάρχουν δυο υποκατηγορίες οι οποίες με την σειρά τους εμπεριέχουν 
η κάθε μια ξεχωριστά επιπλέον πληροφορίες σχετικά με την περιοχή του Κατακόλου, καθώς 
επίσης και οδηγίες για να φτάσει ο επισκέπτης στο Κατάκολο. Για να εισέλθει ο χρήστης στις 
πληροφορίες του μενού Κατάκολο, επιλέγει το κουμπί (βέλος) που βρίσκεται στα αριστερά 
της υποκατηγορίας. 

 

 
Εικόνα 69: Μενού Κατάκολο 

 

 

Οι πληροφορίες της κάθε υποκατηγορίας του μενού Κατάκολο παρουσιάζοντα με τη σειρά 
παρακάτω: 
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Εικόνα 70: Υποκατηγορία Κατάκολο 

 

 
Εικόνα 71: Υποκατηγορία Κατάκολο 

 

Η πρώτη υποκατηγορία και η δεύτερη στο μενού Αξιοθέατα, περιέχουν ένα κουμπί "Πίσω" 
το οποίο οδηγεί στο μενού Κατάκολο. Στη δεύτερη υποκατηγορία υπάρχει και ένα δεύτερο 
κουμπί κάτω αριστερά το οποίο οδηγεί σε επιπλέον υποκατηγορίες οι οποίες εμπεριέχουν τις 
ταξιδιωτικές οδηγίες μέχρι το Κατάκολο. 
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Εικόνα 72: Υποκατηγορία Ταξιδιωτικών οδηγιών  

 

Το κουμπί "Πίσω" οδηγεί πίσω στην δεύτερη υποκατηγορία στην επιλογή "Ταξιδιωτικές 
οδηγίες".  

Οι πληροφορίες της κάθε υποκατηγορίας της επιλογής "Ταξιδιωτικές οδηγίες", 
παρουσιάζοντα με τη σειρά παρακάτω: 

 

 
Εικόνα 73: Πρώτη προτεινόμενη διαδρομή  
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Εικόνα 74: Δεύτερη προτεινόμενη διαδρομή  

 

Οι υποκατηγορίες των προτεινόμενων οδηγιών περιέχουν ένα κουμπί  "Πίσω" το οποίο 
οδηγεί πίσω στις προτεινόμενες οδηγίες.  

Στο μενού Βίντεο υπάρχουν δυο υποκατηγορίες οι οποίες με την σειρά τους εμπεριέχουν η 
κάθε μια ξεχωριστά ένα βίντεο σχετικά με την περιοχή του Κατακόλου. Για να εισέλθει ο 
χρήστης στις πληροφορίες του μενού Βίντεο, επιλέγει το κουμπί (βέλος) που βρίσκεται στα 
αριστερά της υποκατηγορίας. 

 

 
Εικόνα 75: Μενού Βίντεο 



 
77 

 

Τα βίντεο της κάθε υποκατηγορίας του μενού Βίντεο παρουσιάζοντα με τη σειρά παρακάτω: 

 

 
Εικόνα 76: Υποκατηγορία Βίντεο 

 

 
Εικόνα 77: Υποκατηγορία Βίντεο 

 

Οι υποκατηγορίες του μενού Βίντεο περιέχουν ένα κουμπί  "Πίσω" το οποίο οδηγεί πίσω 
στο μενού Βίντεο.  
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ΣΥΜΠΕΡΑΣΜΑΤΑ – ΠΡΟΤΑΣΕΙΣ 
 

ΣΥΜΠΕΡΑΣΜΑΤΑ 

Η παρούσα πτυχιακή εργασία είχε στόχο τη δημιουργία πολυμεσικής διαδραστικής 
εφαρμογής ως εργαλείο προώθησης στη βιομηχανία της κρουαζιέρας. Μέσα στην εφαρμογή 
έγινε προσπάθεια δημιουργίας ενός περιβάλλοντος διεπαφής φιλικό και εύχρηστο, όπου ο 
χρήστης θα μπορεί να περιηγηθεί μαθαίνοντας πληροφορίες για την τουριστική περιοχή του 
Κατακόλου Ηλείας μέσα από μια εικονική ναυτιλιακή εταιρεία την "SeaCruises". Ο τομέας 
της κρουαζιέρας αποτελεί έναν χώρο ο οποίος πρέπει να βρίσκεται κοντά στις τεχνολογικές 
εξελίξεις και να προσαρμόζεται συνεχώς στις ανάγκες των ταξιδιωτών και την παροχή σε 
αυτούς μιας ολοκληρωμένης εμπειρίας. 

Οι εταιρείες κρουαζιέρας καθώς και οι επιχειρήσεις τουρισμού, θα πρέπει να δίνουν μεγάλη 
σημασία στην προώθηση του τομέα της κρουαζιέρας μέσω της ολοένα και μεγαλύτερης 
χρήσης των διαδραστικών πολυμεσικών εφαρμογών και των τεχνικών ηλεκτρονικού 
μάρκετινγκ. Η ανάπτυξη των πολυμέσων και του Internet συντέλεσαν στην αυτοματοποίηση 
των πληροφοριών και στην αναβάθμιση των παρεχόμενων υπηρεσιών στους υποψήφιους 
πελάτες. Με την δημιουργία βάσεων δεδομένων οι οποίες έχουν την δυνατότητα να 
αποθηκεύουν multimedia πληροφορίες (εικόνες, βίντεο, ήχο κλπ.), η ανανέωση των 
πληροφοριών γίνεται εύκολη διαδικασία, καθώς επίσης αυξάνεται και η ποιότητα των 
πληροφοριών.  

Από την άλλη, το ηλεκτρονικό μάρκετινγκ έχει διεισδύσει στη ζωή των εταιρειών που 
δραστηριοποιούνται στον τομέα της κρουαζιέρας αλλά και γενικότερα στον τομέα του 
τουρισμού. Μέσω του ηλεκτρονικού μάρκετινγκ επιτυγχάνεται η άμεση επικοινωνία με τους 
πελάτες, δίνεται η δυνατότητα στις εταιρείες να απευθυνθούν στην παγκόσμια αγορά, on line 
εξυπηρέτηση των πελατών και αναβάθμιση των υπηρεσιών τους και μείωση του κόστους 
υποστήριξης. 

Όλα τα παραπάνω συμβάλουν στην παροχή καλύτερης εξυπηρέτησης από πλευράς 
επιχειρήσεων προς τους υποψήφιους πελάτες οι οποίοι έχουν την δυνατότητα να κλείσουν 
μια κρουαζιέρα εύκολα και γρήγορα δίχως περεταίρω καθυστερήσεις.  

 

ΠΡΟΤΑΣΕΙΣ           

 Μερικές χρήσιμες προτάσεις ώστε να χρησιμοποιούν νέες τεχνολογίες όλο και 
περισσότερες επιχειρήσεις κρουαζιέρας και τουρισμού είναι:  

· Την υιοθέτηση και χρησιμοποίηση ηλεκτρονικών υπηρεσιών από τις 
τουριστικές επιχειρήσεις, καθώς επίσης και την ενημέρωση και κατάρτιση των 
επιχειρηματιών για την χρησιμότητα και την αξιοποίηση των ηλεκτρονικών 
εφαρμογών τουρισμού.  
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· Δημιουργία τεχνολογικών υποδομών και συστημάτων που θα υποστηρίζουν 
την ανάπτυξη τουριστικών πλατφόρμων για την άμεση επικοινωνία με τους 
πελάτες. 
 

· Δημιουργία ιστοσελίδας με δυνατότητα on-line κρατήσεων. 
 

· Δημιουργία σελίδων στα μέσα κοινωνικής δικτύωσης (social media), καθώς 
προσφέρουν παγκόσμια προβολή της επιχείρησης με μηδενικό κόστος.  
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